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PREFACE
Information and Communication Technology (ICT) is so important in the world today that it makes it 
imperative for every person to be competent in the use of ICT for the many tasks that one will have to 
accomplish. This book is written to provide excellent ICT skills for Grade 11 students of Federal Democratic 
Republic of Ethiopia. It is expected that the knowledge and skills gained through this book will help the 
students to use ICT in almost all their courses at school. The book covers selected topics in ICT which offer 
hands-on activities to help students in acquiring the advanced ICT skills.
	 The key features of this book will help the students to:
	 l	 acquire advanced ICT literacy.
	 l	 understand the basic concepts of Information Systems.
	 l	 enhance the knowledge gained during the studies in earlier grades for application of ICT in word 

processing, presentation software, spreadsheets, desktop publishing and database management.
	 l	 develop interest and use ICT for learning in other subjects.
	 l	 understand basic troubleshooting i.e., preventive maintenance, safety issues,  hardware maintenance, 

installing and uninstalling applications software.
	 l	 exploit the Internet.
	 l	 do advance searching using the Internet and use wikis, blogs and podcasts.
	 l	 understand social networking and  design a simple webpage and implement the webpage to a 

server.
	 l	 follow basic ethics in the use of ICT.
	 l	 understand the basic concepts of image processing and multimedia systems.
	 l	 have excellent ICT skills which will serve them well in their future studies.
	 The text has been designed in a simple and user friendly way. It focuses on the applications of ICT, 
which change slowly. This book also illustrates the latest developments in the rapidly changing world of 
ICT. Review questions have also been given at the end of each unit.
	 In future years, the knowledge gained through this book will be very useful to students, in case they 
elect to follow a more-specialist course in Computer Science covering such areas as Computer Architecture, 
Systems Analysis and Design, Data Communications and Fundamentals of Programming. 
	 Suggestions for the improvement of this book will be gratefully acknowledged.

Authors
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Information 
systems

   Unit Outcome
	 Students will be able to:

	 	 know the application of ICT in different sectors;

	 	 understand the components of an information system;

	 	 recognise the application of ICT in different sectors;

	 		 recognise how ICT can change the life of people. 

Unit 1   

1.1 General concepts of Information Systems

When you interact with Information and Communications Technology, you are involved not with a single 
piece of equipment, but with an ever expanding system of interconnected parts. Let us take a closer look 
at what information systems are:

What is a Computer?
A computer is an electronic device that can accept, store and process data under the control of a set of 
instructions.

What is an Information System?
A system is a set of related parts that operate together to perform a specific function. You encounter 
systems everyday. For example, as you read this, the parts of your circulatory system—heart, lungs and 
blood vessels, are moving blood and energy through your body.
	 Information systems, like all other systems, 
are assembled from parts, or components. What 
you consider to be the components or the system 
depends on the scale you choose to examine? For 
example, on a small scale, a personal computer 
is a system containing such components as a 
keyboard, a screen and a system unit. However, 
to an engineer, this system is assembled from 
smaller systems called subsystems. On a larger 
scale, the personal computer is a component 
plugged into a network of other computers 
and other devices in the organization. All of 
these integrated components and systems are Fig. 1.1: Systems and Subsystems
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designed to provide you with the information you need, in the form you need it, when you need it.  
Figure 1.1 shows systems and subsystems.

People
Information systems have not yet gotten to the point 
where they can think, plan and react to changing 
circumstances. So, people work on information systems. 
The more highly paid jobs are going to people who know 
how to use ICT to enhance their skills and performance 
regardless of the field they are in. Only a small minority 
of these people actually design computers or ICT 
systems. The vast majority of end-users use computers in 
their own fields of interest. It is these end-users around 
whom the entire business of ICT is focused. Figure 1.2 
shows people working on computers.

l Some Applications of ICT
At the heart of an organization is information and how it is used. The purpose of an organization is to 
perform a service or deliver a product. Information—whether computer based or not—has to flow within 
an organization in such a way that will help managers and the organization achieve their goals. Figure 1.3 
shows a network society that shares information.

Fig. 1.3: Network society—sharing information

Fig. 1.2: People working on computers
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	 ICT has a large number of applications in different sectors of life. Let us discuss some of these 
applications:

Home
When your computer is connected to a CD-ROM drive, encyclopaedic information, movies and animations 
are instantly available. When your computer is connected to the phone line, you can visit your community 
or other parts of the world. The lines between work, play and education are beginning to disappear as ICT 
resources once available only at work or school become available at the home (see Fig. 1.4).
	 Using the World Wide Web at your home you can research school 
or work assignments, exchange e-mail, join special interest groups, 
download files, play games, or make airline reservations.
	 Sales catalogues are now being computerized and many catalogues 
are even put on the web so you can do online shopping. With an 
Internet connection, you can read the newspaper. You can get study 
material on CD-Rom discs or over the Internet. Home shopping and 
banking are growing areas of ICT. There are sites through which one 
can search for new friends while sitting at home. You can make your 
travel plans, check weather or chat with your friends over the Internet, without moving out of your home.

Office
ICTs are everywhere and offices are using them in newer ways, 
unthought of even a decade ago (see Fig. 1.5). You could list 
thousands of these modern uses.
	 Without computers, the modern offices would almost instantly 
grind to a halt. Computers have become so deeply embedded 
in information processing and communications systems that 
almost no activity would be possible without them. Failure of 
the telecom and electrical company’s computers would shut off 
those services.
	 The ICTs are integrated into offices in the following ways:
	 (i)	 Transaction processing	 (ii)	 Home-based workers
	 (iii)	 Desktop publishing	 (iv)	 Financial analysis
	 (v)	 Product design	 (vi)	 Architectural walk-through
	 (vii)	 Factories etc.

Factory
ICTs have a major impact in industries where products are designed and 
manufactured. Computer-Aided Design (CAD) is used to design and 
develop products. Computer-Aided Manufacturing (CAM) is used to 
manufacture them.
	 Factory floors are becoming increasingly populated by computers used 
for many purposes including inventory control and planning and process 
control.

Fig. 1.4: Using computer at home

Fig. 1.5: People using computers in office

Fig. 1.6: Robot assembling car  
in a factory
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	 Computers are also used to run robots that create, finish, assemble and test products and their 
components. Figure 1.6 shows a robot assembling car in a factory.

Transport
In the transport sector, ICT applications are used to improve road, air and rail transportation. ICT applications 
are noticeable in air traffic control, monitoring of freight and the day-to-day transport system. For example, 
we can book air tickets or railway tickets online. Pilots are trained on software, which simulates flying.
	 The air traffic control and rail signals are also among ICT applications. Figure 1.7 shows air traffic and 
rail managed by computers.

 

Fig. 1.7: Air Traffic and Rail Managed by Computers

Communications

This has been one of the most recognised uses of the ICTs. Various communication technologies, ranging 
from broadcasting to telecommunications and to the Internet are playing effective roles in the acquisition 
and sharing of information. Almost all mobile phones have software embedded in them.
	 The concepts of the ‘information revolution’ and ‘information society’ 
are driven by enormous advancements in ICTs and their application. The 
Internet for example, has provided platforms for sharing information in 
applications such as the e-mail and the World Wide Web.
	 Satellites are commonly used in ICTs. They may simply relay signals 
from one point to another, eliminating the need for wires between two 
locations. They also broadcast TV and even Internet signals that can 
be picked up even by small dish antennae. Figure 1.8 shows satellite 
communication.

Education/Training

The education sector is arguably one major area in which ICTs are playing a remarkable role. Computers 
are serving as the best friend to both the teacher and the students. You can find a computer in a classroom, 
in a library or in a museum. The ability to connect computers and students together over a network such 
as the Internet opens up fantastic educational opportunities. Figure 1.9 shows the applications of ICT in 
school education.

Fig. 1.8: Satellite Communication
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Fig. 1.9: Applications of ICT in School Education

	 In schools computers are increasingly being used to teach ICT courses like the ones you are taking. For 
example, this text has ICT application integrated into it. An e-learning software supplements the knowledge 
you get by studying books. Figure 1.10 shows an online education tutor.

Fig. 1.10: Online Education Tutor

	 Elementary and secondary schools are using computers to play multimedia educational programs and 
to teach kids to explore the web for information. We can give online examination and get instant results. 
We can check our examination results online.
	 Ministry of Education, Ethiopia is soon going to launch a series of educational programs that will be 
broadcast on TV channels. In Ethiopia, various universities  are developing online certification courses for 
those people who do not have time or resources to take regular classes. Thus, various ICT tools help in 
providing education and becoming more knowledgeable as well as more qualified. 
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	 Museums use interactive multimedia to educate visitors on topics from science to fine art. Increasingly, 
these exhibits are being put on the web so you can visit them on your own. ICTs are especially valuable for 
students with special needs. A computer’s voice recognition capabilities and its connection to the Internet 
make it possible for special education users to participate in learning experiences from which they may 
have previously been excluded. For example, the Short Message Service (SMS) can be used to send and 
receive messages by the hearing impaired, the voice activated dialing service can be used by visually 
impaired.
	 Training programs in business and various 
organizations are huge and expensive. To save money and 
improve performance, companies are using Computer-
Based Training (CBT) to train people on procedures and 
techniques they need to know in their jobs. Training 
programs in organizations rely heavily on ICT sectors 
such as video conferencing. Virtual reality is now used 
to train pilots by putting them into a cockpit simulator 
where they can experience the sensations associated 
with various maneuvers as they learn to handle them.  
Figure 1.11 shows people being trained via video 
conferencing.

Health

ICTs are widely used in the field of medicine. They support efficient exchange of information between 
health professionals, they enable transfer of patient records between sites and they can improve clinical 
effectiveness, continuity and quality of care by health professionals. Physicians use ICT to understand the 
human body and to diagnose disorders.
	 Several computer controlled machines are being used in modern 
hospitals. The computer controlled laser machines are used in surgery. 
The complex surgeries can be performed by smallest possible cuts on 
the patient body. This is done by operating through a technique, called 
Endoscopy. This involves the use of computers, small cameras and 
other devices for operating upon the patient (see Fig. 1.12).
	 The ICTs are also helpful in training doctors for surgery. The 
surgeries can be performed on computer controlled models or by using 
virtual reality techniques. These models simulate a real life environment 
by using computers to perform a particular task.

	 Key Concepts

	 	 A system is a set of related parts that operate together to perform a specific function.

	 	 Information systems have not yet gotten to the point where they can think, plan, and react to changing 
circumstances. So, people work on information systems.

	 	 The vast majority of end-users use computers in their own fields of interest.

	 	 Some applications of ICT are at Home, Office, Factory, Transport, Communications, Education/Training and 
Health.

Fig. 1.12: Doctors using computers  
in the field of health

Fig. 1.11: Training via Video Conferencing
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Assessment 1.1
Fill in the Blanks
	 1.	 ......................................... systems, like all other systems, are assembled from parts, or components.
	 2.	 ICT has a large number of ......................................... in different sectors of life.
	 3.	 The surgeries using laser techniques are operated through a technique called ......................................... .
	 4.	 Without computers, the modern ......................................... would almost instantly grind to halt.

State Whether True or False
	 1.	 A system is not a set of related parts that operate together to perform a specific function.
	 2.	 ICTs are everywhere and offices are using them in new ways unthought of even a decade ago.
	 3.	 The education sector is not using ICTs.
	 4.	 Computers are used to run robots that create, finish, assemble, and test products and their 

components.
	 5.	 ICT applications can be used to improve road, air and rail transportation.

Answer the Following
	 1.	 Describe some applications of ICT.

Suggested Activities

	 1.	 Identify the applications of ICT.
	 2.	 Explain and demonstrate detailed examples of application of ICT in the following areas:
		  Home, Office, Factory, Transport, Communications, Education/Training and Health.

Field Trip
	 Organize a field trip to various places like Cyber Cafes, Universities, Private Colleges or Ethiopian 

Telecommunication Corporation (ETC) stations to find out and report on:
	 Applications of ICT.

1.2 Types of Information system in the Organization

The term ‘system’ is derived from the Greek word ‘system’ (to combine), which means an organized 
relationship among functioning units or components. A system exists because it is designed to achieve one 
or more objectives. A system is an orderly arrangement of its components. The components of a system 
have structure and order. The organization determines the flow of control, communication and the chain 
of commands.
	 There are many system concepts which play an important role in understanding the system. The flow of 
information in an organization is very vital. There are various departments in an organization, depending 
on the services or products they provide to us. With each department there are three traditional levels of 
management—top, middle and lower. For making proper decisions—the different levels of managers require 
the right kind of information at the right time. Information system is a system that provides information 
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to people in an organization. There are various types of computer-based information systems, which serve 
different levels of management.

l Definition of System and Characteristics

System
A system is an interrelated set of components with an identifiable boundary working together for some 
purpose. A system has nine characteristics (see Fig. 1.13).

Fig. 1.13: A general Illustration of a System

Characteristics
The system characteristics are discussed below:
	 1.	 Components: A system is made up of components. A component is either an irreducible part or 

an aggregate of parts, also known as a subsystem. The simple concept of a component is very 
powerful. For example, just as with an automobile or a stereo system with proper design, we can 
repair or upgrade the system by changing individual components without having to make changes 
throughout the entire system.

	 2.	 Interrelated components: The components are interrelated, that is, the function of one component is 
somehow tied to the functions of the other components. For example, the work of one component, 
such as producing a daily report of customer orders received, may not progress successfully until the 
work of another component is finished, such as sorting customer orders by date of their receipt.

	 3.	 A boundary: A system has a boundary within which all of its components are contained and that 
establishes the limits of a system, separating the system from other systems. Components within the 
boundary of a system can be changed, whereas things outside the boundary cannot be changed.

	 4.	 A purpose: All of the components work together to achieve some overall purpose for the larger 
system: the system’s  main reason for existing.

	 5.	 An environment: A system exists within an environment which comprises of everything outside the 
system’s boundary. For example, we might consider the environment of a state university to include 
the legislature, prospective students, foundations and funding agencies and the news media. Usually 
the system interacts with its environment, exchanging, in the case of an information system, data 
and information.

	 6.	 Interfaces: The points at which the system meets its environment are known as interfaces, and there 
are also interfaces between subsystems. An example of subsystem interface is the clutch subsystem, 
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which acts as the point of interaction between the engine and transmission subsystems of a car. 
Special characteristics of interfaces are given below:

		  Interface Functions

		  Because an interface exists at the point where a system meets its environment, the interface has 
several special, important functions. An interface provides:

	 (i)	 Security protecting the system from undesirable elements that may want to infiltrate it;

	 (ii)	 Filtering unwanted data, both the elements leaving the system and entering it;

	 (iii)	 Coding and decoding incoming and outgoing messages;

	 (iv)	 Detecting and correcting errors in its interaction with the environment;

	 (v)	 Buffering, providing a layer of slack between the system and its environment, so that the system 
and its environment can work on different cycles and at different speeds;

	 (vi)	 Summarizing raw data and transforming them into the level of detail and format required 
throughout the system (for an input interface) or in the environment (for an output interface).

		  Because interface functions are critical in communication between system components or a system 
and its environment, interfaces receive much attention in the design of information systems.

		  It is the design of good interfaces that allows different systems to work together without being too 
dependent on each other.

	 7.	 Input: A system takes input from its environment in order to function. Mammals, for example, take 
in food, oxygen and water from the environment as input. A system cannot function properly if 
inputs are inaccurate or faulty.

	 8.	 Output: Finally, a system returns output to its environment as a result to its functioning and thus 
achieves its purpose.

	 9.	 Constraints: A system must face constraints in its functioning because there are limits (in terms of 
capacity, speed, or capabilities) to what it can do and how it can achieve its purpose within its 
environment. Some of these constraints are imposed inside the system (e.g., a limited number of staff 
available), whereas others are imposed by the environment (e.g., due dates or regulations imposed by 
government or some other agency).

Case Study
A Fast-Food Restaurant as a System

Now you are familiar with the definition of a system and its nine important characteristics. Let us take an example 
of a system and use it to illustrate the definition and system’s characteristics. Consider a system that is familiar to 
you: a fast-food restaurant (see Fig. 1.14).

	 How is a fast-food restaurant a system? Let us take a look at the fictional Hot Spots restaurant in Addis 
Ababa, Ethiopia. First, it has components, or subsystems. The physical subsystems are: kitchen, dining room, 
counter, storage, and office.                                                                                          
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Fig. 1.14: A fast-food restaurant as a system

	 As you might expect, the subsystems are interrelated and work together to prepare food and deliver it to the 
customers, one purpose for the restaurant’s existence. Food is delivered daily, kept in storage, prepared in the 
kitchen, sold at the counter, and often eaten in the dining room.

	 The boundary is represented by its physical walls, and the primary purpose of the restaurant’s existence is 
to make a profit for its owners, Abraham and Yasin Mohamed.

	 The restaurant’s environment consists of those external elements that interact with it, such as customers 
(many of whom come from nearby Adama University), the local labour supply, food distributors (much of the 
produce is grown locally), banks, and neighbourhood fast-food competitors.

	 It has one interface at the counter, where customers place orders, and another at the back door, where food 
and supplies are delivered. Still another interface is the telephone that managers use regularly to talk with 
bankers and food distributors.

	 The restaurant faces several constraints. It is designed for the easy and cost-effective preparation of certain 
popular foods, such as hamburgers and coffees, which constraints the restaurant in the foods it may offer 
for sale. Its size and its location in the university neighbourhood constrain how much money it can make on 
any given day. The Addis Ababa Health Department also imposes constraints, such as rules governing food 
storage.

	 Inputs include, but are not limited to, ingredients for the burgers and other food as well as cash and labour. 
Outputs include, but are not limited to, prepared food, bank deposits, and trash.

l Application of Information System Types
The main purpose of a computer-based information system is to provide managers (and various categories 
of employees) with the appropriate kind of information to help them make decisions. The six types of 
computer-based information systems which serve different levels of management are:
	 Transaction Processing Systems (TPSs) – For lower managers.
	 Management Information Systems (MISs) and Decision Support Systems (DSSs) – For middle managers.
	 Executive Support Systems (ESSs) – For top managers.
	 Office Automation Systems (OASs) and Expert Systems (ESs) – For all levels, including non-management.
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	 Figure 1.15 illustrates these information systems for three levels of management: 

Fig. 1.15: Illustration of six information systems for three levels of management

	 Let us describe some of these information systems: 

1.	 Transaction Processing Systems (TPSs)

In most organizations, particularly business organizations, most of what goes on consists largely of 
transactions. A transaction is a recorded event having to do with routine business activities. This includes 
everything concerning the product or service in which the organization is involved: production, distribution, 
sales, orders. It also includes materials purchased, employees hired, taxes paid etc. These days in most 
organizations, the bulk of such transactions are recorded in a computer-based information system. These 
systems tend to have clearly defined inputs and outputs, and there is an emphasis on efficiency and 
accuracy. Transaction processing systems record data but do little in the way of converting data into 
information.
	 A Transaction Processing System (TPS) is a computer-based information system that keeps track of the 
transactions needed to conduct business (see Fig. 1.16).
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Fig. 1.16: Transaction processing system

	  Some features of a TPS are given below:

	 (i)	 Input and output. The inputs to the system are transaction data: bills, orders, inventory levels etc. 
The output consists of processed transactions: bills, paychecks etc.

	 (ii)	 For lower managers. Because the TPS deals with day-to-day matters, it is principally of use to 
supervisory managers. That is, the TPS helps in making tactical decisions. Such systems are not 
usually helpful to middle or top managers in an organization.

	 (iii)	 Produces detail reports. A manager at this level typically will receive information in the form of 
detailed reports. A detail report contains specific information about routine activities. For example, 
the information needed to decide whether to restock inventory. 

	 (iv)	 One TPS for each department. Each department or functional area of an organization—research 
and development, production, marketing, accounting and finance, and human resources—usually 
has its own TPS. For example, the accounting and finance TPS handles order processing, accounts 
receivable, inventory and purchasing, accounts payable, order processing, and payroll.

	 (v)	 Basis for MIS and DSS. The database of transactions stored in a TPS provides the basis for Management 
Information Systems and Decision Support Systems, as described next.

2.	 Management Information Systems (MISs)

A Management Information System (MIS) is a computer-based information system that uses data recorded by 
TPS as input into programs that produce routine reports as output (see Fig. 1.17).
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Fig. 1.17: Architecture of a management information system

	 Some feature of the MIS are given below:

	 (i)	 Input and output. Inputs consist of processed transaction data, such as bills, orders, and paychecks, 
plus other internal data. Outputs consist of summarized, structured reports: budget summaries, 
production schedules etc.

	 (ii)	 For middle managers. The MIS is intended principally to assist middle managers—specifically to 
help them with tactical decisions. It helps them to spot trends and get an overview of current 
business activities.

	 (iii)	 Draws from all departments. The MIS draws from all five departments or functional areas, not just 
one.

	 (iv)	 Produces several kinds of reports. Managers at this level usually receive information in the form of 
several kinds of reports: summary, exception, periodic, demand.

		  Summary reports show totals and trends. For example, a report showing total sales by office, by 
product, and by salesperson, as well as total overall sales.

		  Exception reports show out-of-the-ordinary data. For example, an inventory report listing only those 
items of which fewer than 20 are in stock.

		  Periodic reports are produced on a regular schedule. Such daily, weekly, monthly, quarterly, or annual 
reports may have sales figures, income statements, or balance sheets. They are usually produced on 
paper, such as computer printouts.

		  Demand reports produce information in response to an unscheduled demand. A director of finance 
might order a demand credit-background report on an unknown customer who wants to place a 
large order. Demand reports are often produced on a terminal or microcomputer screen, rather than 
on paper.
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3.	 Decision Support Systems (DSSs)
A Decision Support System (DSS) is a computer-based information system that provides a flexible tool for analysis 
and helps managers focus on the future (see Fig. 1.18). Whereas a TPS records data and a MIS summarizes data, 
a DSS analyzes data. To reach the DSS level of sophistication in information technology, an organization 
must have established TPS and MIS systems first.

Fig. 1.18: Decision support system

	 Some features of a DSS are given below:
	 (i)	 Inputs and outputs. Inputs include internal data—such as summarized reports and processed 

transaction data—and also data that is external to the organization. External data may be produced 
by trade associations, marketing research firms, Central Statistical Authority (CSA), Addis Ababa, 
Ethiopia and other government agencies.

		  The outputs are demand reports on which a top manager can make decisions about unstructured 
problems.

	 (ii)	 Mainly for middle managers. A DSS is intended principally to assist middle managers in making 
tactical decisions. Questions addressed by the DSS might be, for example, whether interest rates will 
rise or whether there will be a strike in an important materials-supplying industry.

	 (iii)	 Produces analytic models. The key attribute of a DSS is that it uses models. A model is a mathematical 
representation of a real system. The models use a DSS database, which draws on the TPS and MIS files, 
as well as external data such as stock reports, government reports, and national and international 
news. The system is accessed using the DSS software.

	 The model allows the manager to do a simulation—play a “what-if” game—to reach decisions. Thus, 
the manager can simulate an aspect of the organization’s environment in order to decide how to react to 
a change in conditions affecting it. By changing the hypothetical inputs to the model, the manager can see 
how the model’s outputs are affected by doing so.
	 Many DSSs are developed to support the types of decisions faced by managers in specific industries, 
such as airlines or real estate. Curious how airlines decide how many seats to sell on a flight when so 
many passengers are in waiting! Wonder how owners of those big apartment complexes set rents and 
lease terms? Investors in commercial real estate use a DSS called RealPlan to forecast property values up 
to 40 years into the future, based on income, expense, and cash-flow projections. Ever speculate about how 
insurance carriers set different rates. Many companies use DSSs called Geographic Information Systems 
(GISs), such as MapInfo and Atlas GIS, which integrate geographic databases with other business data and 
display maps.
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4.	 Executive Support Systems (ESSs)
An Executive Support System (ESS) is an easy-to-use DSS made especially for top managers; it specifically supports 
strategic decision making (see Fig. 1.19). An ESS is also known as Executive Information System (EIS). It draws on 
data not only from systems internal to the organization but also from those outside, such as news services 
or market-research databases.

Fig. 1.19: Illustrating components of an ESS

	 An ESS might allow senior executives to call up predefined reports from their personal computers, 
whether desktops or laptops. They might, for instance, call up sales figures in many forms—by region, by 
week, by anticipated year, by projected increases. 
	 An ESS includes capabilities for analyzing data and doing “what-if” scenarios. ESSs also have the 
capability to browse through summarized information on all aspects of the organization and then zero in 
on (“drill down” to) detailed areas the manager believes require attention.

5.	 Office Automation Systems (OASs)
The information systems discussed so far—are designed for managers of various levels. There exist two 
types of information systems that are intended for workers of all levels, including those who are not 
managers: office automation systems and expert systems. Let us discuss the office automation systems.
	 Office Automation Systems (OASs) combine various technologies to reduce the manual labour required in 
operating and efficient office environment. Used throughout all levels of an organization, OAS technologies 
include fax, voice mail, e-mail, scheduling software, word processing, and desktop publishing, among others  
(see Fig. 1.20).

Fig. 1.20: Office automation systems



Unit 1 – Information Systems

16	  	 Information Communication Technology — Grade 11 Student Textbook

	 The backbone of an OAS is a network—LAN, intranet, extranet—that connects everything. All office 
functions—dictation, typing, filing, copying, fax, microfilm and records management, telephone calls and 
switchboard operations—are candidates for integration into the network.

Activity 1.1
Description of the Types of Information Systems

Students in their class will describe and discuss the types of Information systems.

What is Information System?

A system that is designed to capture, transmit, store, retrieve, manipulate, and or display information used in 
one or more business processes.

Types of Information Systems

For most businesses, there are a variety of requirements for information. As a result, businesses tend to have 
several “information systems” operating at the same time. The main kinds of information systems in business 
are described below:

Information 
System

Description

Transaction 
Processing 
Systems

Transaction Processing Systems (“TPSs”) are designed to process routine transactions efficiently and 
accurately. A business will have several (sometimes many) TPS; for example:
- Billing systems to send invoices to customers
- Systems to calculate the weekly and monthly payroll and tax payments
- Production and purchasing systems to calculate raw material requirements
- Stock control systems to process all movements into, within and out of the business.

Management 
Information 
Systems

A Management Information System (“MIS”) is mainly concerned with internal sources of 
information. MIS usually takes data from the transaction processing systems and summarizes it 
into a series of management reports.

MIS reports tend to be used by middle management and operational supervisors.

Decision-
Support 
Systems

Decision-Support Systems (“DSSs”) are specifically designed to help management make decisions 
in situations where there is uncertainty about the possible outcomes of those decisions. DSS 
comprises tools and techniques to help gather relevant information and analyze the options and 
alternatives. DSS often involves use of complex spreadsheet and databases to create “what-if” 
models.

Executive 
Support 
Systems

An Executive Support System (“ESS”) is designed to help senior management make strategic 
decisions. It gathers, analyses and summarizes the key internal and external information used in 
the business.

A good way to think about an ESS is to imagine the senior management team in an aircraft 
cockpit—with the instrument panel showing them the status of all the key business activities. 
ESS typically involves lots of data analysis and modeling tools such as “what-if” analysis to help 
strategic decision-making.

Office 
Automation 
Systems

Office Automation Systems (“OASs”) are systems that try to improve the productivity of employees 
who need to process data and information. Perhaps the best example is the wide range of software 
systems that exist to improve the productivity of employees working in an office (e.g., Microsoft 
Office XP) or systems that allow employees to work from home or whilst on the move.
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	   Key Concepts
	 	 Information system is a system that provides information to people in an organization.

	 	 A system is an interrelated set of components with an identifiable boundary working together for some 
purpose.

	 	 The major characteristics of a system are:

		  Components, Interrelated components, A boundary, A purpose, An environment, Interface, Input, Output and 
Constraints.

	 	 The types of information systems are:

		  Transaction Processing System, Management Information System, Decision Support System, Executive 
Information System and Office Automation System.

Assessment 1.2
Fill in the Blanks

	 1.	 ...................................... is a system that provides information to people in an organization.
	 2.	 A system is made up of ...................................... .
	 3.	 A ...................................... is a computer-based information system that uses data recorded by TPS as input 

into programs that produce routine reports as output.
	 4.	 A ...................................... is a computer-based information system that provides a flexible tool for analysis 

and helps managers focus on the future.

	 5.	 A ...................................... is an easy-to-use DSS made especially for top managers.

State Whether True or False
	 1.	 The flow of information in an organization is not vital.
	 2.	 A system must face constraints in its functioning.
	 3.	 A Transaction Processing System is a computer-based information system that keeps track of the 

transactions needed to conduct business.
	 4.	 Office Automation System combines various technologies to reduce the manual labour required in 

operating and efficient office environment.
	 5.	 An interface has no special, important functions in a system.

Answer the Following
	 1.	 Define the system and give its characteristics.
	 2.	 Explain the definition of each type of Information System.
	 3.	 Explain the application of each type of Information System.

Suggested Activities

	 1.	 Explain the types of Information System.
	 2.	 Explain the definition of the types of Information System.
	 3.	 Explain the application of all types of Information System, e.g., describe the main advantages and 

disadvantages of an on-line Airline time table and a printed one.
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Field Trip
	 Organize a field trip to various Business Houses, Universities or Ethiopian Telecommunication Corporation 

(ETC) stations to find out and report on:

	 Types of Information Systems.

1.3 Impact of ICT in Everyday Life
The increasing use of technology in all aspects of society makes confident, creative and productive use of 
ICT an essential skill for life. ICT can be used to find, develop, analyse and present information, as well 
as to model situations and solve problems. ICT enables rapid access to ideas and experiences from a wide 
range of people, communities and cultures, and allows pupils to collaborate and exchange information on 
a wide scale.
	 According to Minasse Zewdu, citizenship manager at Microsoft East Africa Limited, Ethiopia Branch 
Office—	If people cannot use ICT devices in their own language and cultural context, it causes a digital device. The 
establishment of such standards plays a key role in bridging the digital device and making friendly—ICT available to 
all citizens.	  			   (Source: www.ethiopianreview.com)
	 ICT acts as a powerful force for change in society and citizens should have an understanding of the social, 
ethical, legal and economic implications of its use, including how to use ICT safely and responsibly. Increased 
capability in the use of ICT supports initiative and independent learning, as pupils are able to make informed 
judgements about when and where to use ICT to enhance their learning and the quality of their work.
	 Let us describe the impact of ICT in everyday life.

l What is a Digital Device?
A digital device is a device that works with discrete numbers or digits. For  example, Digital Computers, 
Digital Cameras, MP3 Players, Mobile Chargers, Cell Phone, PDA, GSP portables, Mobile VoIP etc.  
Figure 1.21 shows some digital devices.

            

Fig. 1.21: Some Digital Devices

l Impact of Using Computers in Offices
Computer has brought many changes in employment, including changes to office equipment, office 
location, work schedules and the types of work people are seeking. Computer technology not only has 
solved problems but also has created some, for instance, a certain amount of culture shock as individuals 
attempt to deal with the new technology. A major role of computer science has been to alleviate problems, 
mainly by making computer systems cheaper, faster, more reliable, and easier to use. 
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	 Computers are forever present in the offices. Computers are helpful because they offer a wide range of 
functions and services that are not available anywhere else. There are four main uses—word processing, 
Internet/communications, digital video/audio composition, and desktop publishing. Although one can create 
a typed paper with a typewriter, the computer has more features to do it with. Internet and communications, 
digital video and audio composition, and desktop publishing are all features that are only offered on computers. 
Electronic mail has made it easy to send messages worldwide via computer communication networks (see  
Fig. 1.22). With these tools human society has progressed exponentially.
	 Office automation has become the term for linking workstations, printers, database system, and other 
tools by means of a local area network. An eventual goal of office automation has been termed the paperless 
office (see Fig. 1.23). Although such changes ultimately make office work much more efficient, they have not 
been without cost in terms of purchasing and frequently upgrading the necessary hardware and software 
and of training workers to use the new technology.

	 	

	 Fig. 1.22: E-mail—making easy to send messages	 Fig. 1.23: Paperless office

	 The increasing educational opportunities from the use of computers in turn increase the professional 
job opportunities in offices. There are millions of websites that provides great opportunities to earn a huge 
amount of cash every month by investing either few Birrs or investing nothing! According to a research 
almost after every five minutes a person joins the Internet community and almost after every eleven minutes 
a person joins an online job. A person having a degree of arts or science or even if he/she has no degree or 
education experience still can earn enough money to live a contended life. So, as opportunities grow more, 
we might expect 0% poverty rate in the near future.
	 Technological development also negatively influences the advancement chances of workers in the offices. 
Most workers want to have a good position and obtain a higher salary. One of the best ways to have a 
good salary in the past was to gain various kinds of experience and knowledge.  When computers were 
not used in the offices, a worker who started in low-level job had a fair opportunity to change position to 
a higher level, but they do not have the opportunities now. The experience and knowledge are not valuable 
anymore because workers having high-skills which are required by employers can start out on the high 
level jobs. In consequence, employees not having high-skills do not have the chances of advancement even 
though they have worked for a long time.
	 There have been many job losses as computers have begun to do more tasks in the offices.  For 
examples:
	 1.	 A reduced number of clerical staff, as there is less need for filing.
	 2.	 A reduced number of manual workers as we now have robots which can do the work.
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l Impact of Mobile Phones
Mobile phones are the easiest and the simplest of the methods to stay 
connected with others, and moreover they provide a sense of security. Help 
is just a dial away in the event of emergency. However, the importance of 
mobile phones is not limited to this only, it goes much beyond this (see 
Fig. 1.24).

Positive Effects of Cell Phones

Cell phones are a tool of convenience. Having a cell phone now makes 
people reachable in almost any location as long as there is good 
reception. This makes individuals easier to contact. Ease of access is 
not the only benefit of cell phones today though, as cell phones offer 
features that have many other benefits.

	 1.	 Cost Options for all Customers: To reduce the cost of a cell phone purchase, customers can agree to 
long-term contracts requiring credit checks. For those not wanting long-term contracts or for those 
who have questionable credit, phones can be purchased with prepaid minutes.

	 2.	 Size: No longer do you need to worry about the bulky car phones of the 1980s. The average cell phone 
today is smaller than the size of a checkbook, making it easy to transport.

	 3.	 Conducting Business: Cell phones make it easier to make business arrangements when you are 
travelling away from your office by e-mailing or texting business associates.

	 4.	 Internet Access: Having Internet access on cell phones allows individuals to check items such as 
airline schedules, sports scores, weather and traffic conditions.

	 5.	 Cameras: Many cell phones now come with cameras built into the cell phone. This can be very 
helpful for an individual involved in a car accident that does not have a camera. He or she can take 
photographs of the damage using his or her cell phone and submit it to the insurance company if 
needed.

Negative Impact of Mobile Phones

The convenience of mobile phones cannot be denied, but neither can the way they have negatively impacted 
daily living. Some of the effects can be negated if boundaries are set, such as not answering the phone 
when running errands, so time is used more efficiently.
	 1.	 Spillover: The line between work and personal time has practically been eradicated because the 

phones enable us to be contacted at any time.
	 2.	 Dangerous: Stories are commonplace of people having an accident because they were distracted 

while driving and talking on a mobile phone.
	 3.	 Health: While the topic remains controversial, there are people who believe the microwave radiation 

the phones emit can cause such problems as cancer and Alzheimer’s disease from prolonged use.
	 4.	 Environment: Wirefly.org reports approximately 100 million mobile phones are replaced annually. 

If they are not recycled, resources such as glass and metal go to waste, and toxins such as arsenic 
and lead seep into the ground.

	 5.	 Manners: People can be inconsiderate when using the phone in public, doing things such as talking 
during a movie, holding up a line at a store and bumping into others because they are not paying 
attention to where they are walking.

Fig. 1.24: Impact of Mobile in everyday 
life—an Ethiopian farmer in fields
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	 6.	 Addiction: Reports say that there are teens who become addicted to using the phone and have to be 
weaned of its usage by parents.

	 Such is the impact of mobile phones in our life.

l Impact of Satellite Broadcasting
Satellite technology plays an important role in communication globally. The speed of satellite transmission 
is from 256 KBPS (Kilo Bits Per Second) to 100 MBPS (Mega Bits Per Second). Satellites work by receiving 
and transmitting radio signals from one earth station to another. 
	 Satellite systems have the advantages of transmission from point to multipoint systems, which 
means transmissions can be beamed to areas that are 
geographically dispersed (see Fig. 1.25). Over the years, 
satellite communication has improved tremendously, 
especially the expansion of the capacity of transponders. 
Transponders are the devices that receive signals from the 
earth and retransmit these signals across stations within its 
‘footprint’. This expansion of capacity has strengthened the 
signals emitted by satellite; consequently, satellite-receiving 
dishes have been reduced considerably in size. 
	 Satellite technology has the potential to beam signals 
across different countries; this has improved international 
telephony enormously. It has also improved television 
signal transmission as well; programmes are transmitted to 
television operators from one country to another through 
satellite technology. Over the years satellite transmission for 
telephony has been considered inappropriate. This is due 
to the fact that the time taken to beam the signal to space 
and back to the earth creates a short delay in the exchange 
of conversations; this also leads to an echo in telephonic 
conversations.
	 Satellite voice communication, for a long time was out of reach for rural subscribers in developing 
countries. However, developments over the years have made direct access voice services available on a 
large scale, even to rural subscribers. For example, these services can be accessed through a briefcase size 
portable terminal. Perhaps, the most interesting development from this scenario is the development of 
a fixed cellular system. This system is very beneficial to rural subscribers. This system uses the existing 
cellular mobile telecommunications system with fixed rural subscribers. 
	 The Ethiopian Telecommunications Corporation (ETC) is trying its best to improve the ICT development. 
The Ethiopian government has proposed three primary projects:
	 (i)	 A government network (‘Woredanet’)
	 (ii)	 An education network (‘Schoolnet’)
	 (iii)	 An agriculture network (‘Agrinet’).
	 As mentioned earlier, Ministry of Education will soon launch educational TV programs that will be 
broadcast by satellites to the remotest corners of Ethiopia. Similarly, many universities are launching 
courses using satellite communication. Such advancements in delivering education through satellites will 
greatly help in reducing illiteracy, alleviating poverty, making the society more information rich, and in 
integrating the nation.

Fig. 1.25: Satellite Broadcasting
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l Differences between Information Poor and Information Rich Society
It is needless to say that we are now in the Information Age. There are huge differences in people’s 
ability to obtain and act on information. Recently, this situation has been affected in different ways by 
technological waves. The invention of the Internet and the Web, specifically, created both opportunities 
and threats in terms of people’s access to information.
	 The Information Age/Digital Divide separate the information rich and the information poor. The 
Organization for Economic Co-operation and Development (OECD) defines the digital divide as the 
difference between individuals, households, businesses and geographic areas with regard to 
	 (a)	 their opportunities to access ICTs, and
	 (b)	 their use of the Internet for a wide variety of activities.
	 It is the gap between those who have real access to information and communications technology and 
who are able to use it effectively, and those who do not have such access. ICT can bridge the gap between 
information poor and information rich (see Fig. 1.26).

               

Fig. 1.26: ICT can bridge the gap between Information Poor and Information Rich

	 The information rich have good access to information—especially online, but also through more 
traditional media such as newspapers, radio, television, and books—and can plan their lives and react to 
changes in circumstances on the basis of what they know or can find out. The information poor do not 
have such access and are vulnerable to all kinds of pressures. 
	 Although information poor and information rich could be found in all countries, the majority of 
information poor are in developing countries and information inequalities is a more serious problem in 
these countries due to several political, economic, educational and cultural factors. And to bridge this gap, 
information needs to be distributed to the public through mass media.
	 Lack of access to ICT goods and services poses social and economic disadvantages. More and more, 
developing countries are recognizing that they cannot compete in the new global market unless they 
take advantage of the ICT revolution. Countries that do not undertake measures to enhance their ICT 
infrastructure risk not just being marginalized but also being completely bypassed in the new global order. 
The experience of a number of countries, like Singapore, Malaysia and Korea, demonstrate that bold actions 
in bringing their countries into the digital age pay off.
	 It is striking how quickly the new ICTs (e.g., mobile phones and Internet) have spread across Africa. 
The greatest development in communication technology in Africa in the 21st century has been in the area 
of mobile telephony.
	 The Ethiopian Government is making strong efforts to make ICT as a tool in its strategies of eradicating 
poverty. It has been also considered that ICT is a vital aid to solve the poverty issues with the effective 
application of the technology. This is because ICT benefits the poor by providing information that is critical 
for poverty reduction.
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Activity 1.2
Students will study the following report and then in small groups discuss why mobile phone has 
been such a successful technology?

	 Cell phones have become a necessity for many people throughout the world. The ability to keep in touch 
with family, business associates, and access to e-mail are only a few of the 
reasons for the increasing importance of cell phones. Today’s technically 
advanced cell phones are capable of not only receiving and placing phone 
calls, but also storing data, taking pictures, and being used as walkie-
talkies, to name just a few of the available options.

	 When cell phones were first introduced to the public, they were bulky, 
expensive, and some even required a base unit that had to be transported 
along with the phone. Good reception was a major problem and in general, 
early cell phones could only be used in certain locations where the signal 
was particularly strong. As cell phone technology advanced, the difficulty 
in using them became less of a problem. Today, cell phone reception 
has improved greatly due to the use of satellites and wireless services. As 
cell phones improved and became simple to use, the importance of cell 
phones increased accordingly.

            

		  Fig. 1.28:  Mobile Internet	 Fig. 1.29: Cell phone tracking system

	 Cell phones are the perfect way to stay connected with others and provide the user with a sense of security. 
In the event of emergency, having a cell phone can allow help to reach you quickly and could possibly save 
lives. However, the importance of cell phones goes way beyond personal safety. Modern cell phones are capable 
of Internet access, sending and receiving photos and files, and some cell phones are equipped with Global 
Positioning System (GPS) technology, allowing for use in most locations around the world and allowing the 
cell phone to be found or the user located in the event of loss or emergency.

	 Cell phone reception has become reliable and of high quality due to advances in wireless technology. Wireless 
service providers offer excellent packages and promotions for cell phone users. Finding a dependable service 
provider is no longer an issue for cell phone users. The expansion of the wireless service provider industry gives 
cell phone users a choice and the increased competition has caused a drop in prices of wireless cell phone 
service. The importance of cell phones goes way beyond the ability to make or receive phone calls. Cell phone 
users can instantly send data to the home or office, check for important e-mail, use their cell phone as a PDA 

Fig. 1.27:  Mobile Phone—a necessity 
for most people
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or calendar, and store photos which can be easily transferred to a 
PC or laptop computer.

	 Cell phone manufacturers have produced a wide range of cell 
phones, which sell for prices that range from very inexpensive to 
over thousands of Birr. The available options give users the choice 
of purchasing a basic cell phone to use simply for making calls, 
or choosing a complex, technologically advanced cell phone that 
can perform as many or even more tasks that a home computer. 
Over the past decade, the increasing importance of cell phones 
has made them almost a necessity for most people. Even remote 
and underdeveloped countries have some access to cell phone 
technology and wireless services.

	 The importance of cell phones has increased the competition in the 
wireless service provider industry, making cell phones very affordable 
and very easy to use. Cell phones have become almost a status symbol in addition to the convenience and security 
that comes from owning them.

	   Key Concepts

	 	 ICT enables rapid access to ideas and experiences from a wide range of people, communities and cultures, 
and allows pupils to collaborate and exchange information on a wide scale.

	 	 A digital device is a device that works with discrete numbers or digits.

	 	 Computer has brought many changes in employment, including changes to office equipment, office location, 
work schedules and the types of work people are seeking.

	 	 Mobile phones are the easiest and the simplest of the methods to stay connected with others, and moreover 
they provide a sense of security.

	 	 Satellite technology plays an important role in communication globally.

	 	 The Information Age/Digital Divide separate the information rich and the information poor.

Review Questions
Fill in the Blanks
	 1.	 ...................................... can be used to find, develop, analyse and present information, as well as to model 

situations and solve problems.
	 2.	 ...................................... technology plays an important role in communication globally.
	 3.	 The ...................................... have good access to information—especially online, but also through more 

traditional media such as newspapers, radio, television, and books.

State Whether True or False
	 1.	 A digital device is a device that does not work with discrete numbers or digits.
	 2.	 Computers are forever present in the offices.

Fig. 1.30: E-mail through Mobile
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	 3.	 Mobile phones are the easiest and the simplest of the methods to stay connected with others, and 
moreover they provide a sense of security.

	 4.	 Ministry of Education will not launch educational TV programs that will be broadcast by satellites to 
the remotest corners of Ethiopia.

Multiple Choice Questions
	 1.	 A system is generally assembled from smaller systems called
		  (a)	 Subsystems	 (b)	 Boundary	 (c)	 Thinking	 (d)	 None  of these
	 2.	 Which of the following is/are the application(s) sector(s) of ICT?
	 	 (a)	 Home	 (b)	 Office	 (c)	 Communications	 (d)	 All of these
	 3.	 Which of the following is not a characteristic of a system?
		  (a)	 Components	 (b)	 Purposeless	 (c)	 An environment	 (d)	 Interfaces
	 4.	 Which of the following is trying to improve the ICT development in Ethiopia?
		  (a)	 Ethiopian Electric and Light Power Corporation
		  (b)	 Ministry of Agriculture
		  (c)	 Ethiopian Telecommunications Corporation	
		  (d)	 Ethiopian Road Authority

Match the Following

Column A Column B

1. Education/Training (a) 256 KBPS–100 MBPS
2. Executive Support Systems (b) Health
3. Negative impact of mobile phones (c) Online education tutor
4. Speed of satellite transmission (d) For top managers

Answer the Following
	 1.	 Describe the impact of ICT in everyday life.
	 2.	 What is a digital device? Describe the impact of using computers in offices.
	 3.	 Give the differences between information poor and information rich society.

Suggested Activity
      Describe the impact of ICT in everyday life, considering the aspects listed.

Field Trip
	 Organize a field trip to various organizations, offices, mobile shops and Ethiopian Telecommunication     

Corporation (ETC) stations to find out and report on:
	 Impact of ICT in everyday life.
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Enhancing the 
use of software

   Unit Outcome
	 Students will be able to:

	 	 recognise to choose appropriate software tools to solve problems, illustrate ideas, and clarify thinking in 
other subjects chosen for study in Grade 11.

2.1 USING APPLICATION SOFTWARE

Software refers to the operating instructions and applications that allow computers to process the numbers, 
pictures, sounds, and text we enter into them. In Grades 9 and 10, you have studied about Application 
Software. We know that application software is the software that is designed to satisfy a particular need of 
a particular environment. Some examples of application software are:
	 (i)	 Word Processing Software
	 (ii)	 Presentation Software
	 (iii)	 Spreadsheet Software
	 (iv)	 Desktop Publishing Software
	 (v)	 Database Management  Software

	 In this Unit, we will enhance the use of application software. 

l Word Processing

Overview
Word processing software was originally designed as a replacement for the typewriter. Now-a-days word 
processing program such as MS-Word 2007 can support photos and drawings, mathematical calculations, 
text in table format, text in varying sizes, shapes, colors and even sound bites.

Creating a Document
Using MS-Word 2007, we can create a variety of documents such as memos, letters, reports, research 
papers, brochures, announcements, newsletters, envelops, labels, and much more.
	 To start Word 2007, 
	 Click Start → All Programs → Microsoft Office → Microsoft Office Word 2007
	 A blank document namely Document1 is created. Figure 2.1 shows the Word 2007 document screen 
elements. 

Unit 2   
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Fig. 2.1: Word 2007 document screen elements

	 Now, you can type the text as per your need in the document you have just created and save it for 
future use. You can also open an existing document.

Editing and Formatting Documents
You can edit and format word documents using Word’s powerful editing and formatting features. Editing 
includes inserting, replacing, deleting text, using Undo and/or Redo and spell checking etc. Formatting can 
include tasks as changing the font; aligning and indenting text; changing line and paragraph spacing; and 
inserting elements such as bullets, numbers, tables and pictures, etc.
	 To edit a document in Word 2007, perform the following steps:
	 1.	 Open a document.
	 2.	 To insert text, position the insertion point in the desired location and then type the text. You can 

delete the text by pressing the Backspace key or Delete key.
	 3.	 If you make a change to text, such as deleting selected text, and then change your mind, use the 

Undo and/or Redo buttons on the Quick Access toolbar.
	 4.	 For spell checking, click the Review tab and then click the Spelling & Grammar button in the Proofing 

group. Ignore or change as needed. Click OK when check is complete.
	 5.	 Save the document by clicking the Save button on the Quick Access toolbar (or press Ctrl + S).
	 To format a document in Word 2007, perform the following steps:
	 1.	 Open a document and select some text from the document.
	 2.	 Click the Font group dialog box launcher (or press Ctrl + D).
	 3.	 To change the font, choose desired font. To apply font effects, click desired effect check box.
	 4.	 Click OK.
	 5.	 You can use the various buttons on Paragraph group in Home tab for aligning the text (Left, Center, 

Right, and Justify), line and paragraph spacing, inserting bullets and numbering. 
	 6.	 Save the document.

Section Breaks
Sections are independent parts of the text that can be formatted independently. Section breaks are used to 
create sections within your MS-Word document. To see the section breaks have your non-printing characters 

turned on (use CTRL + SHIFT + 8 or  under Home tab to hide/display the non-printing characters). 
There is no keyboard shortcut to insert a section break.
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	 There are situations when you want to insert a section break in a Word document before the application 
does it automatically. Section breaks are very helpful when creating books or reports. For each section, you 
can specify formatting, such as header and footer appearance, sequence of page numbers, page orientation 
(portrait or landscape), and page margins.
	 To insert the section breaks, perform the following steps:
	 1.	 Open a word document and type some text in it (if it is newly created).
	 2.	 Place the cursor where you want the section break.
	 3.	 Click the Page Layout tab.
	 4.	 Click the Breaks button (see Fig. 2.2).
	 5.	 You will get a Page Breaks and Section Breaks window (see Fig. 2.3).

      

	 Fig. 2.2: Clicking Breaks button 	 Fig. 2.3: Page Breaks and Section Breaks window

	 6.	 Now you can choose from four types of section breaks: 
	 (i)	 Next Page inserts a section break and starts the new section on the next page. Useful when you 

start a new chapter.
	 (ii)	 Continuous inserts a section break and starts the new section on the same page. Useful when you 

want to have different formatting within one page.
	 (iii)	 Even Page inserts a section break and starts the new section on the next even-numbered page. 

If you want your chapters to always begin on the even page, use this one.
	 (iv)	 Odd Page inserts a section break and starts the new section on the next odd-numbered page. If 

you want your chapters to always begin on the odd page, use this one.
		  The most used is Next Page.
	 7.	 Pick the one you want and your section break is in place.
	 8.	 Repeat as many times as needed.

	 9.	 Save the document.

To display/hide the non-printing characters, use CTRL + SHIFT + 8 or  under Home tab.
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Mail Merge
You use mail merge when you want to create a set of documents, such as a birthday invitation that is 
sent to many friends and relatives or a sheet of address labels. Each letter or label has the same kind of 
information, yet the content is unique. For example, in letters to your friends and relatives, each letter can 
be personalized to address each of them by name. The unique information in each letter or label comes 
from entries in a data source.
	 To mail merge in Word 2007, perform the following steps:
	 1.	 Click Start Mail Merge in the Start Mail Merge group in the Mailings tab and select the type of 

document you would like to create (see Fig. 2.4).
		  For example, you can select Letters, Envelopes, or Labels. Or, select Step by Step Mail Merge Wizard for 

more help creating your document.
	 2.	 Click Select Recipients in the Start Mail Merge group in the Mailings tab to add recipients to the 

mailing. You can select Type New List (see Fig. 2.5). You can also opt to Use Existing List or Select 
from Outlook Contacts.

	 	
	 Fig. 2.4: Clicking Start Mail Merge	 Fig. 2.5: Clicking Type New List in Select Recipients

	 3.	 In the New Address List box shown in Fig. 2.6, begin entering your contacts (if the predesigned fields 
satisfy your need otherwise you can delete or insert field(s) you want).  

		  To delete or add fields to your mail merge document, click the Customize Columns button on the 
New Address List dialog box (see Fig. 2.6). The Customize Address List dialog box opens (see Fig. 2.7). 
Click Add, Delete or Rename to alter the field types. You can also use the Move Up and Move Down 
buttons to rearrange the order of the fields. When you have done all the changes, click OK.

  
	 Fig. 2.6: New Address List box to add recipients	 Fig. 2.7: Customize Address List dialog box
	 to the mail merge database	 for adding and deleting fields
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	 	 After customizing the field(s), if it was required, you can use the Tab key to move between fields 
in the New Address List dialog box. Each set of fields is referred to as an entry. To add additional 
recipients, click the New Entry button. To delete an entry, select it and click Delete Entry. Click Yes 
to confirm the deletion.

		  After adding all your recipients, click OK on the New Address List dialog box. Name the data source 
and click Save.

	 Useful Tip

After typing the data in the last field of the last record, do not press the Tab key. If you do so, a new blank 
record will be created. 

	 4.	 To insert a field into your document, click Insert Merge Field in the Mailings tab (see Fig. 2.8). Select 
the field you would like to insert. The field name appears where you have the cursor located in 
your document.

		  You can edit and format the text surrounding the field. Formats applied to the field will carry over 
to your finished document. You can continue to add fields to your document.

	 5.	 Before you print your letters, you should preview them to check for errors. In particular, pay attention 
to spacing and punctuation surrounding the fields. You should make sure that you have inserted the 
correct fields in the correct places.

		  To preview the letters, click Preview Results in Preview Results group in the Mailings tab (see Fig. 2.9). 
Use the arrows to navigate through the letters.

	 6.	 You may notice an error in the data for one of your documents. You cannot alter this data in the 
merge document. Instead, you will have to fix it in the data source. To do this, click Edit Recipient 
List in the Start Mail Merge group in the Mailings tab (see Fig. 2.10). 

	 	 	

	 Fig. 2.8: Clicking Insert Merge Field 	 Fig. 2.9: Clicking Preview Results for 	 Fig. 2.10: Clicking Edit Recipient
	 for inserting a field into the document 	 previewing the Mail Merge letters	 List for correcting errors in Mail
			    Merge fields

		  In the box that opens, you can alter the data for any of your recipients. You can also limit the 
recipients. Simply uncheck the box next to recipients’ names to omit them from the merge operation. 
When you have made the corrections, click OK.

	 7.	 After you have reviewed your documents, you are ready to 
finalize them by completing the merge. Click the Finish & Merge 
button in the Finish group in the Mailings tab (see Fig. 2.11).

		  You can select Edit Individual Documents, Print Documents, or 
Send E-mail Messages. If you select Print Documents or Send E-mail 
Messages, you will be prompted to enter a range.

	 8.	 Click Edit Individual Documents at the drop down list.
Fig. 2.11: Clicking Finish & Merge for 
finalizing the Mail Merge documents
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	 9.	 At the Merge to New Document dialog box, click the OK button. The letters are merged with the 
records and displayed in a new document.

	 10.	 Save the merged letters in the normal manner and name the document.

Header & Footer
Headers and footers are areas in the top, bottom, and side margins (the blank spaces outside the printing 
area on a page) of each page in a document. You can insert or change text or graphics in headers and 
footers. For example, you can add page numbers, the time and date, a company logo, the document title 
or file name, or the author’s name.
	 You can also specify different headers and/or footers for the first page and the rest of the document. 
Or, if you insert section breaks, you can even give every single page in your Word document a different 
header and footer!
	 To insert header and footer in Word 2007, perform the following steps:
	 1.	 Open an existing Word document or create a new one and type some text in it.
	 2.	 Click the Insert tab.
	 3.	 Click Header button in the Header & Footer group (see Fig. 2.12).

Fig. 2.12: Clicking Header button 

	 4.	 Click desired option at drop-down gallery (see Fig. 2.13). It inserts a header in the document.

Fig. 2.13: Inserting Header in a document
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You can edit the header by clicking the Insert tab, clicking the Header button in the Header & Footer, and 
then clicking Edit Header at the drop-down list.

	 5.	 Click the Close Header and Footer button in Close group in Design tab (see 
Fig. 2.14) or double-click in the body of the document. This makes the 
document active and dims the header. Now you can edit your document 
text.

	 6.	 To insert footer, click the Insert tab. Click Footer button in the Header & 
Footer group. Click desired option at drop-down gallery. Footer is inserted in the document.

	 7.	 To exit the footer, double-click in the body of the document.
	 8.	 Scroll through the document and observe how the header and footer appear on each page.
	 9.	 Save the document.

You can work with headers and footers the same way you work with the body of your document. You 
can click on buttons in tabs. This means you can change the font and formatting. You can also copy 
text from the body of your document and paste it into a header or footer or vice versa.

l Presentation Software
Overview
Presentation software such as MS-PowerPoint 2007 allows users to create slide shows that can be viewed 
on the computer or projected onto a large screen. The shows can include clipart, graphs and charts, photos, 
drawings, video clips, sound, and text. The slide transition effects provide the attention-getting movement 
those appeals to sales people and teachers.

Preparing a Presentation
You can prepare a presentation using a template provided by PowerPoint or create your own presentation. 
Preparing a presentation consists of general steps such as creating and editing slides; adding enhancements 
to slides; and saving, running, previewing, printing, and closing a presentation.
	 To start PowerPoint 2007, 
	 Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007
	 A blank presentation namely Presentation1 is created. Figure 2.15 shows the PowerPoint 2007 window 
screen elements. 

Fig. 2.15: PowerPoint window screen elements

Fig. 2.14: Clicking Header and 
Footer to exit header 



Unit 2 – Enhancing the Use of Software

	 Information Communication Technology — Grade 11 Student Textbook	 	 33

	 To create and run the presentation with Installed Template, perform the following steps:
	 1.	 Click Office Button.
	 2.	 Click New.
	 3.	 Click Installed Templates option.
	 4.	 Double-click the desired template. 
	 5.	 To run the presentation, click the Slide Show tab and then click From Beginning button in the Start 

Slide Show group.
	 6.	 Read the information in the first slide and then click the left mouse button. Continue reading the 

information in the slides and clicking the left mouse button to advance to the next slide. When a 
blank screen displays, click the left mouse button to end the slide show.

	 7.	 Save the presentation by clicking the Save button on the Quick Access toolbar.
	 8.	 Close the presentation by clicking the Office Button and clicking Close at the drop-down list.
	 To create your own presentation, perform the following steps:
	 1.	 Click Design tab.
	 2.	 Click desired theme in Themes group.
	 3.	 To add slide, click Home tab.
	 4.	 Click New Slide button. Enter some text and figures on the slide.
	 5.	 Continue to add more slides if you want.
	 6.	 To save the presentation, click the Save button on Quick Access toolbar.
	 7.	 The Save As dialog box appears. Identify the location to save a file and type presentation file 

name.
	 8.	 Press Enter key.

A placeholder is a location on a slide marked with a border that holds text or an object. You can use keys 
on the keyboard to move the insertion point to various locations within a placeholder in a slide.

	 To add transition and transition sound to all slides in presentation, perform the following steps:
	 1.	 Open the presentation.
	 2.	 Click Animations tab.
	 3.	 To add transition, click More button at right side of transition icons and then click desired transition 

at drop down gallery. Finally click Apply To All button.
	 4.	 To add transition sound, click Transition Sound button arrow and then click desired transition at 

drop down gallery. Finally click Apply To All button.
	 5.	 Save the presentation.
	 To print the presentation, perform the following steps:
	 1.	 Open the presentation.
	 2.	 Click Office Button.
	 3.	 Point to the Print option, and then click Print Preview.
	 4.	 Click the Print button in the Print group in the Print Preview tab.
	 5.	 At the Print dialog box, click OK.
	 6.	 Click the Close Print Preview button. 
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	 7.	 Switch on the connected printer. Click Print.
	 8.	 At Print dialog box, specify how you want the presentation printed.
	 9.	 Click OK.

Editing and Formatting Slides
You can edit and format slides and slide elements to customize and personalize the presentation. Editing 
can include functions such as rearranging and deleting slides; cutting, copying, and pasting text; changing 
the font, paragraph alignment, and paragraph spacing; and changing the design theme, theme color, and 
theme font. You can add insert clipart images, pictures in presentations. Customization of presentations by 
formatting of objects and text boxes is also possible in PowerPoint 2007.
	 To delete and move slides in PowerPoint 2007, perform the following steps:
	 1.	 Open the presentation.
	 2.	 To delete slide, click Slide Sorter button in view area on Status bar. Click desired slide. Press the 

Delete key.
	 3.	 To move slide, click Slide Sorter button in view area on Status bar. Drag slide to desired location.
	 4.	 Save the presentation.
	 To cut/copy and paste text in slides, perform the following steps:
	 1.	 Open the presentation.
	 2.	 Select a slide.
	 3.	 To cut and paste text, select the text and click Cut button in the Clipboard group in the Home tab. 

Position insertion point at the desired location and click the Paste button in the Clipboard group.
	 4.	 To copy and paste text, select the text and click Copy button in the Clipboard group in the Home tab. 

Position insertion point at the desired location and click the Paste button in the Clipboard group. 
	 5.	 Save the presentation.
	 To apply fonts and font effects, perform the following steps:
	 1.	 Open a presentation.
	 2.	 Select the text.
	 3.	 To change the font and font size, click the desired button in the Font group in the Home tab.
	 4.	 To apply font effects such as bold, italic, underline, case, color etc., click the desired button in the 

Font group in the Home tab.
	 5.	 Save the presentation.

You can apply font by using the Font dialog box that can be opened by clicking the Font group dialog 
box launcher in the Font group in the Home tab.

	 To insert an image or clipart in a presentation, perform the following steps:
	 1.	 Open a presentation.
	 2.	 Click the slide on which you want to insert the image or clipart.
	 3.	 Click Insert tab.
	 4.	 Click Picture button or Clip Art button.
	 5.	 At Insert Picture dialog box, navigate to desired folder or at Clip Art task pane, type desired category, 

and then press Enter key.
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	 6.	 Double-click the desired picture file or clip art image. Arrange the picture or clip art in the slide and 
resize it if necessary. 

	 7.	 Save the presentation.
	 To insert text box in a presentation, perform the following steps:
	 1.	 Open the presentation.
	 2.	 Click Insert tab.
	 3.	 Click Text Box button.
	 4.	 Click in the slide or drag to create text box.
	 5.	 Save the presentation. 

l Spreadsheets

Overview

Spreadsheet software can be used for both simple and complex calculations. Current versions such as MS-
Excel 2007 can also support graphics and perform some database tasks, such as sorting. 
	 Because the formulas are used to do calculations, you can ask, “If I spend only Birr 100 per day on 
coffee in my office instead of Birr 500, how much money will I save at the end of the month?” When you 
replace one value with another, the program will recalculate your budget automatically.  

Creating Workbooks
We know that a document in MS-Excel is made of one or more worksheets. A document in Excel is called a 
workbook. In other words, a workbook is the group of worksheets that belong to the same document.
	 To start Excel 2007, 
	 Click Start → All Programs → Microsoft Office → Microsoft Office Excel 2007
	 Figure 2.16 shows the Excel 2007 screen elements.

Fig. 2.16: Excel 2007 screen elements
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	 When you start MS-Excel, it directly creates a workbook for you. Each worksheet in Excel contains 16,384 
columns and 1,048,576 rows. An Excel Workbook initially contains three worksheets labeled Sheet1, Sheet2, 
and Sheet3. You can use that workbook as per your need. At any time, you can create a new workbook. 
	 A worksheet is primarily made of cells that are used to enter data. There are different types of values 
that can be entered in a cell. We can enter labels in columns or rows to create the worksheet layout. To 
put a value in a cell, click that cell and type the value you want. We can create formulas to add, subtract, 
multiply, or divide to calculate the desired results.

To create a workbook based on the templates provided by MS-Excel, click the Office Button and click 
New. This would display the New Workbook dialog box. In the left frame, under Templates, you can click 
a category of your choice.

Editing and Formatting Worksheets
The contents of a cell can be edited directly within the cell or in the Formula bar. Clearing a cell can involve 
removing the cell contents, format, or both. The Spelling feature is a useful tool for correcting typing errors 
within a worksheet. After completing a spelling check, you should proofread the worksheet since the 
spelling checker will not highlight all errors and cannot check the accuracy of values.
	 To edit a cell in Excel 2007, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Double-click the cell to be edited.
	 3.	 Insert and/or delete text.
	 4.	 Press Enter key or click another cell.
	 5.	 Save the worksheet.
	 To spell check in Excel 2007, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Click Review tab.
	 3.	 Click Spelling button.
	 4.	 Click Ignore Once, Ignore All, Change, or Add to dictionary as needed.
	 5.	 Save the worksheet.
	 You can insert/delete rows and columns using the Insert/Delete button in the Home tab. Also, the contents 
of a cell or the range of cells can be moved and copied to another location in the worksheet.
	 To insert/delete rows and columns in Excel 2007, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Select the rows or columns.
	 3.	 Click Insert/Delete button on the Home tab.
	 4.	 Click Insert Sheet Rows/Insert Sheet Columns. 
		  Or
		  Click Delete Sheet Rows/Delete Sheet Columns.
	 5.	 Save the worksheet.
	 To move or copy cell(s) contents in Excel 2007, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Select the cell or range of cells, i.e., source cell(s).
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	 3.	 Click Cut or Copy button.
	 4.	 Select starting destination cell.
	 5.	 Click Paste button.
	 6.	 Save the worksheet.
	 Excel allows you to apply formatting attributes and add color to enhance the appearance of the worksheet 
and draw a reader’s attention to important titles, totals, or other results.
	 To change font, font size and font attributes, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Select cell(s).
	 3.	 Click Font button arrow or Font Size button arrow or desired attribute button (bold, italic, underline 

etc.).
	 4.	 Click desired font or desired size.
	 5.	 Deselect cell(s).
	 6.	 Save the worksheet.

	 1.	 You can use the Format Cells dialog box (press Ctrl + Shift + F to open the dialog box) from the 
Font tab selected to change the font, font size, font style, and color of text.

	 2.	 Click Undo button on the Quick Access toolbar or press Ctrl + Z to reverse the last action. Click 
Redo button on the Quick Access toolbar or press Ctrl + Y to redo the last action. Excel 2007 stores 
up to 100 actions that can be undone or redone and you can repeat actions as many times as 
you need. Some actions (such as Save) cannot be reversed with Undo.

Using Functions and Creating Charts
Excel’s built-in functions make the task of writing formulas easier. The functions are grouped by category 
such as statistical, financial, data, and logical. The Insert Function dialog box is available to assist us in 
locating and creating function. Charts can be easily created to emphasize or compare data sets.
	 To use the built-in functions in Excel 2007, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Make the desired cell active.
	 3.	 Click the AutoSum  button arrow in the Editing group in the Home tab.
	 4.	 Click the desired function.
	 5.	 Type or select the argument range.
	 6.	 Press Enter key or click Enter button on the Formula Bar.
	 7.	 Save the worksheet.
	 To create charts in Excel 2007, perform the following steps:
	 1.	 Open the worksheet.
	 2.	 Select the cells containing the data you want to chart.
	 3.	 Click Insert tab.
	 4.	 Click Column/Pie/Bar button in the Charts group.
	 5.	 Click desired type chart.
	 6.	 Move and/or resize as required.
	 7.	 Apply design options.
	 8.	 Save the worksheet.
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If condition with AND or OR
From Grade 10, you know that “IF” function of Excel is a conditional construct that displays one or the 
other value in a cell based on the condition applied. If the condition is true, one value is displayed otherwise 
the other value is displayed. 
	 The syntax of IF function is: 
	 IF (Condition, Value if True, Value if False)
	 The three items between the parentheses are the arguments of IF function. Here,
	 Condition is what you want to test for.
	 Value if True is what you want to do if the answer to the first argument is TRUE.
	 Value if False is what you want to do if the answer to the first argument is FALSE.
	 You can use the AND, OR, NOT, and IF function to create conditional formulas.  
	 AND( ): It returns TRUE if all its arguments are TRUE; returns FALSE if one or more argument is 
FALSE. The syntax of AND( )function is: 
	 AND(logical1, logical2, ...)
	 Here, 	logical1, logical2, ...  are 1 to 255 conditions you want to test that can be either TRUE or FALSE.
	 For example,
		  =AND(TRUE,FALSE) will result FALSE.
		  =AND(3+4=7,3+5=8) will result TRUE.
	 Now, open a new spreadsheet, and perform the following steps: 
	 1.	 Widen the B column, as we will be putting a message in cells B2 and B3. 
	 2.	 Now click in cell A1 and type Data, click in cell B1 and type Description(Result).
	 3.	 Type the numbers 40 and 105 in cells A2 and A3 respectively. Now, type the formulas 
		  =AND(1<A2,A2<100) and
		  =IF(AND(1<A3,A3<100),A3,”The value is out of range”) 
		  in cells B2 and B3 respectively.
		 Press Enter key to see the results. Figure 2.17 shows the result of these formulas. 

Fig. 2.17: Use of AND

	 In the above example, make sure that all the commas and double quotes are in the correct place; 
otherwise Excel will give an error message.
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	 OR(  ): It returns TRUE if at least one of the arguments is TRUE; returns FALSE if all arguments are 
FALSE. The syntax of OR( )function is: 
	 OR(logical1, logical2,...)
	 Here, 	logical1, logical2,...   are 1 to 255 conditions you want to test that can be either TRUE or FALSE.
	 For example,
		  =OR(TRUE) will result TRUE.
		  =OR(3+4=8,3+5=9) will result FALSE.
	 Again, open a new spreadsheet, and perform the following steps: 
	 1.	 Widen the B column, as we will be putting a message in cells B2 and B3. 
	 2.	 Now click in cell A1 and type Data, click in cell B1 and type Description(Result).
	 3.	 Type the numbers 40 and 105 in cells A2 and A3 respectively. Now, type the formulas
		  =OR(1>A2,A2>100) and
		  =IF(OR(1<A3,A3<100),A3,”The value is out of range”) 
		  in cells B2 and B3 respectively.
	 Press Enter key to see the results. Figure 2.18 shows the result of these formulas. 

Fig. 2.18: Use of OR

Activity 2.1
Use Appropriate Software Tools e.g., Spreadsheet Package to Solve a Mathematical 
Problem

In small groups, the students will use appropriate software tools e.g., spreadsheet package to solve mathematical 
problem.

Problem: Suppose we want to find the distance traveled if an athlete runs around a football field five, six and 
seven times. It is given that the length of the field is 109.80 meters and its breadth is 48.80 meters.
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Formula Used: The distance traveled is simply the field’s perimeter multiplied by the number of laps.
The perimeter of a rectangular field is the sum of the distances of each side of the field, or

		  Perimeter	 =	 2 × (Length + Breadth) units

Using Spreadsheet Package to Solve the Problem

Excel is very useful when solving algebraic equations. The program, however, will not actually perform itself any 
algebraic operations; you must supply the proper formula.

	 To solve the given problem using Excel 2007, perform the following steps:

	 1.	 Start MS-Excel 2007.

	 2.	 Open a new worksheet. Widen the cells so that the data and results may be visible properly.

	 3.	 Type the data in the cells (see Fig. 2.19).

	 4.	 Click cell D3. Type the formula =A3*2*(B3+C3) in Formula Bar and press Enter key.

	 5.	 Excel calculates and displays the result in cell D3 (see Fig. 2.19).

	 6.	 Copy and paste the formula of cell D3 in cells D4 and D5 to get the other two results in cells D4 and 
D5 (see Fig. 2.19). The worksheet may look like the following: 

Fig. 2.19: Solving a mathematical problem using Excel 2007

	 7.	 Save the worksheet for future use.

	 8.	 Close MS-Excel 2007.

l Publishing Software

Overview

Desktop publishing programs are used to create professional quality documents that combine text and 
other visual elements in non-linear arrangements. MS-Publisher 2007 is designed specifically to handle the 
various desktop publishing needs of individuals and small organizations. 

	 Publisher makes it easy to efficiently create a wide range of publications, from simple flyers (one-page, 
one-sided publications that are designed to be read at a glance) to complex brochures. Even novice users 
are able to work productively in Publisher.
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Creating New Publication
When you first start Publisher 2007, you see the Getting Started with Microsoft Office Publisher 2007 window, 
from which you can start a new publication or open an existing one.
	 To start Publisher 2007, 
	 Click Start → All Programs → Microsoft Office → Microsoft Office Publisher 2007
	 The Getting Started with Microsoft Office Publisher 2007 window opens (see Fig. 2.20).

Fig. 2.20: Publisher 2007 Getting Started window

	 To create and save a publication based on a template, perform the following steps:
	 1.	 Choose a publication type from Publication Types in the left pane of the Getting Started with Microsoft 

Office Publisher 2007 window.
	 2.	 In the Publication Types list, click the publication category you want.
	 3.	 In the right pane, set the publication options and then click Create.
		  A publication based on the selected template opens in a new Publisher program window  

(see Fig. 2.21)

Fig. 2.21: Publisher 2007 program window screen elements
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		  The Publisher program window displays all the tools you need to customize the publication. You 
can perform most tasks by clicking commands on menus or buttons on toolbars. Common tasks are 
available in the Format Publication task pane to left of the publication workspace.

	 4.	 To save a publication, click Save As on the File menu.
	 5.	 Click the New Folder button on the toolbar of the Save As dialog box.
	 6.	 Type a name for the folder, press Enter key and name the file if necessary.
	 7.	 Click Save.

	  Useful Tip

If you are already working on a publication, then you can display the Getting Started with Microsoft Office 
Publisher 2007 window by clicking New on the File menu (but not by clicking the New button on the Standard 
toolbar).

	 To open an existing publication, perform the following steps:
	 1.	 Open Publisher 2007.
	 2.	 In the Recent Publications pane of the Getting Started with Microsoft Office Publisher 2007 window, click 

From File.
	 3.	 In the Open Publication dialog box, browse to and select the file you want to open.
	 4.	 Click OK.
	 To print preview and print a publication, perform the following steps:
	 1.	 Open the publication you want to print.
	 2.	 To print preview it, on the Standard toolbar, click the Print Preview button. Click Close to Close Print 

Preview.
	 3.	 To print it, on the File menu, click Print.
	 4.	 In the Print dialog box, make the settings as per your need.
	 5.	 Click OK.
	 6.	 Click Close on the File menu.

	  Useful Tip

If several publications are open and you want to quit Publisher, you do not have to close the publications 
first. You can simply click Exit on the File menu.

	 To create a business card, edit a logo and add it to the Content Library, perform the following steps:
	 1.	 In the Publications Types list, click Business Card. In the center pane, click the design you want.
	 2.	 In the right pane, under Customize, select the Color scheme, Font scheme, and Business Information.
	 3.	 Under Options, select the Page size and whether to include a logo image. Then click Create.
	 4.	 On the Objects toolbar, click the Design Gallery Object button, and in the left pane of the Design 

Gallery, click Logos. If necessary, enlarge the gallery window by dragging its border so that you can 
see the logos in the center pane.
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	 5.	 In the center pane, click the style of logo you want to create, set any other options necessary, and 
then click Insert Object.

	 6.	 Now drag the logo to the area of the publication you want.
	 7.	 On the Arrange menu, click Ungroup, and then click a blank area of the publication to release the 

selection and enable editing of the individual logo elements.
	 8.	 Finally make any edits and add any images you want to the logo. Then select the elements in the 

logo (hold down the Shift key as you click each item), and group them.

l Database Management 
Overview
Database software such as MS-Access 2007 is designed to keep track of information. They allow you to 
rearrange it alphabetically, numerically, or chronologically. Or you can filter the data to display only those 
items that match your criteria, such as names of students who scored more than 90% marks in Grade 10.
	 Database software can easily do calculations, such as showing monthly subtotals and an annual total 
for school expenses, but complex mathematical calculations should be done using the spreadsheets.
	 Table 2.1 shows some database objects.

Table 2.1: Some Database Objects

Object Description

Table Organizes data in fields (columns) and records (rows). A database must 
contain at least one table. The table is the base upon which other objects are 
created.

Query Used to display data from a table that meets a conditional statement and/or 
to perform calculations. For example, display only those records in which the 
city is Addis Ababa.

Form Allows fields and records to be presented in a different layout than the 
datasheet. Used to facilitate data entry and maintenance.

Report Prints data from tables or queries.

	 Table 2.2 shows the basic elements of a database.
Table 2.2: Basic Elements of a Database

Element Description

Field A single component of information about a person, place, item, or object.

Record All fields related to one logical unit in the table such as a student, 
teacher.

Table All of the related records for one logical group.

Database A file containing related tables and objects.

A primary key is a field, which provides a unique identification for each record in the table. The primary 
key must contain unique data for each record. 
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Creating Database

A database is comprised of a series of objects used to enter, manage, and view data. In a database the 
data is organized in the form of tables. A table contains information for related items such as students, 
employees, and inventory etc., broken down into individual units of information. Access 2007 is different 
from the other applications within the Microsoft Office suite 2007. 

	 To start Access 2007, 

	 Click Start → All Programs → Microsoft Office → Microsoft Office Access 2007
	 The Getting Started with Microsoft Office Access window opens (see Fig. 2.22).

Fig. 2.22: Getting Started with Microsoft Access screen

	 Click the Office Button and then click Open at the drop-down menu, or click the More hyperlink in the 
Open Recent Database pane or click the name of an existing database in the Open Recent Database pane.
	 The Access 2007 screen appears (see Fig. 2.23). 

Fig. 2.23: Access 2007 screen elements
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	 When you create or open a database, it opens in a database window. The navigation pane displays the 
names of objects (e.g., Tables, Queries, Forms, and Reports etc.).
	 To open and close the existing objects in Access 2007, perform the following steps:
	 1.	 Start Access 2007.
	 2.	 Open the database file.
	 3.	 Double-click object name in navigation pane (it displays the names of the objects within the database 

grouped by tables).
	 4.	 Click the Close button at the top of right corner of the work area.
	 5.	 Click the Office Button and then click Close Database at the drop-down menu.
	 To add records to an existing table in Datasheet view, perform the following steps:
	 1.	 Open the table.
	 2.	 Click the New (blank) record button in the Record Navigation bar or click New button in the Records 

group in the Home tab.
	 3.	 Type data in the fields. When you press Tab or Enter key after typing the last field, the record is 

saved automatically.
	 4.	 Close the table.
	 To add records to an existing table in Form view, perform the following steps:
	 1.	 Open the form.
	 2.	 Click the New (blank) record button in the Record Navigation bar or click New button in the Records 

group in the Home tab.
	 3.	 Type data in the fields. When you press Tab or Enter key after typing the last field, the record is 

saved automatically.
	 4.	 Close the table.
	 To delete records in a datasheet and form, perform the following steps:
	 1.	 Open the table datasheet or form.
	 2.	 Make the record to be deleted active.
	 3.	 Click Delete button in the Records group in the Home tab.
	 4.	 Click Yes.

	 1.	 Always back up the database file before deleting record(s).

	 2.	 Check that you are deleting the correct record before clicking Yes. Click No if you have selected 
the wrong record by mistake.

	 3.	 The field values in ID (when you create a new table by adding records, Access 2007 automatically 
includes a field named ID that is defined as the primary key) are not dynamic—they do not 
change once the number has been assigned in the field. The numbers in the navigation bar are 
dynamic and update to reflect the current number of records that exist in the table.

	 To sort records by single field, perform the following steps:
	 1.	 Open the table to be sorted.
	 2.	 Click in the column by which you want to sort.
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	 3.	 Click Ascending or Descending button in the Sort & Filter group in the Home tab.
	 4.	 Close the table. Access saves the sort order when the table is closed.
	 To create a table by adding records, perform the following steps:
	 1.	 Click the Create tab.
	 2.	 Click Table button in the Tables group.
		  A blank datasheet appears. Notice that a column with the field name ID has been created 

automatically. Access 2007 creates ID as an AutoNumber field in which the field value is assigned 
automatically as you enter each record.

	 3.	 Type records in blank datasheet.
	 4.	 Double-click Field1.
	 5.	 Type desired field name.
	 6.	 Press the Enter key or click outside field.
	 7.	 Repeat Steps 4–6 for remaining columns of the table.
	 8.	 Click the Save button on the Quick Access toolbar.
	 9.	 In the Save As dialog box, type the name of the table.
	 10.	 Press the Enter key or click OK.
	 To create a table in Design View in Access 2007, perform the following steps:
	 1.	 Click the Create tab.
	 2.	 Click Table Design button in the Tables group.
	 3.	 Type the field names, change data types, add descriptions, or modify other field properties, as you 

want.
	 4.	 Assign primary key (make active desired primary key field and click Primary Key button in the Tools 

group in the Table Tools Design tab).
	 5.	 Click the Save button on the Quick Access toolbar.
	 6.	 In the Save As dialog box, type the name of the table.
	 7.	 Press the Enter key or click OK.

Creating Queries and Forms

Queries and forms are objects based on tables and are created to extract, view, and maintain data. Queries 
can be used to view specific fields from tables that meet a specific criterion. Forms provide a user-friendly 
interface for entering, editing, deleting, and viewing records in tables. 
	 To create a query in Design view in Access 2007, perform the following steps:
	 1.	 Click the Create tab.
	 2.	 Click the Query Design button in the Other group.
	 3.	 Double-click the required table in Show Table dialog box.
	 4.	 Close the Show Table dialog box.
	 5.	 Add the required field names from the field list box to columns in the design grid.
	 6.	 Click the Save button.
	 7.	 Type the query name and click OK.
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	 8.	 Click the Run button in the Results group in the Query Tools Design tab. The result is displayed in 
Datasheet view.

	 9.	 Close the query.
	 To create a form in using Form Wizard in Access 2007, perform the following steps:
	 1.	 Click the Create tab.
	 2.	 Click More Forms button in the Forms group.
	 3.	 Click Form Wizard at the drop-down list.
	 4.	 Choose the table for which you want to create form.
	 5.	 Select fields to include in the form.
	 6.	 Click Next.
	 7.	 Choose the form style.
	 8.	 Click Next.
	 9.	 Type the form title.
	 10.	 Click Finish. The completed form appears in Form view in the work area.

	 11.	 Close the form.

Main/Sub Reports

A sub report is a report that is inserted in another report. When you combine reports, one of them must 
serve as the main report that contains the other report. A main report is either bound or unbound. A bound 
report is one that can display data and has a table or query specified in its Record Source property. An 
unbound report is one that is not based on a table or query (that is, the Record Source property of the report 
is empty).
	 We create reports to generate professionally designed printouts of information from tables or queries. 
	 To create report using Report tool, perform the following steps:
	 1.	 Click Table object in the navigation pane. Here, we select STUDENT table.

	 2.	 Click Create tab (see Fig. 2.24).

Fig. 2.24: Clicking Create tab
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A table or query must be selected first before clicking the Report button (see Fig. 2.24).

	 3.	 Click the Report button in the Reports group. A report is generated (see Fig. 2.25).

Fig. 2.25: A created report

	 4.	 Save the report.
	 To insert a subreport in a report, perform the following steps:
	 1.	 Open the main report in Design view. Then double-click the Report Selector to display the Property 

sheet pane (see Fig. 2.26).

Fig. 2.26: Preparing to create a subreport

	 2.	 On the Data tab, click the Record Source arrow, and select the table or query on which the subreport 
will be based.

	 3.	 On the Design contextual tab, in the Controls group, click the Subform/Subreport button , and then 
click a point on the main report. The SubReport Wizard appears (see Fig. 2.27).



Unit 2 – Enhancing the Use of Software

	 Information Communication Technology — Grade 11 Student Textbook	 	 49

Fig. 2.27: SubReport Wizard

	 4.	 In the SubReport wizard, with the Use existing Tables and Queries option selected, click Next.
	 5.	 In the Tables/Queries list, click the source you want to use.
	 6.	 In the Available Fields list, double-click the fields you want to move them to the Selected Fields list, 

and then click Next.
	 7.	 Click Next and then click Finish. The subreport will be inserted in the report (see Fig. 2.28).

Fig. 2.28: A subreport

	 8.	 Double-click on the subreport in the Navigation Pane to see its contents (see Fig. 2.29).

Fig. 2.29: Contents of the subreport

	 9.	 Save the subreport.

Group Section
Grouping allows you to separate groups of records visually and to display introductory and summary 
data for each group.
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Group Records in the Report Wizard
Grouping lets you organize and arrange records by group, such as Sex (male or female) or by Region etc. 
Groups can be nested so that you can easily identify the relationships among the groups and find the 
information you want quickly. You can also use grouping to calculate summary information, such as totals 
and percentages.
	 To create group records in a report, perform the following steps:
	 1.	 Start MS-Access 2007. Click the table name in the Navigation pane. Here, we select STUDENT.
	 2.	 On Create tab, in the Reports group, click Report Wizard. Access starts the Report Wizard (see Fig. 2.30).

Fig. 2.30: Report Wizard

	 3.	 Select the desired fields.
	 4.	 Click Next.
	 5.	 On the page of the Report Wizard that asks Do you want to add any grouping levels?, click one of the 

field names in the list, and then click Next (see Fig. 2.31). To add grouping levels, double-click any 
of the field names in the list to add them to your report. 

Fig. 2.31: Adding grouping
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	 	 You can also remove a grouping level by double-clicking it in the page display on the right side of 
the dialog box. Use the arrow buttons to add and remove grouping levels, and adjust the priority 
of a grouping level by selecting it and clicking the up or down priority buttons. Access adds each 
grouping level and shows it nested within its parent grouping level.

	 6.	 Click Grouping Options to display the Grouping Intervals dialog box for selecting a grouping interval 
(if you want), then click OK. 

	 7.	 Follow the directions on the remaining pages of the Report Wizard. On the last page, you can edit 
the title of the report. This title will be displayed on the first page of the report, and Access will also 
save the report, using the title as the document name. You can edit both the title and the document 
name later. 

	 8.	 Click Finish. Access automatically saves the report and displays it in Print Preview, which shows you 
the report as it will look when printed. Figure 2.32 shows the grouped records in the report.

Fig. 2.32: Grouped records in a report

      Key Concepts
	 	 Word processing program such as MS-Word 2007 can support photos and drawings, mathematical calculations, 

text in table format, text in varying sizes, shapes, colors and even sound bites.
	 	 Mail merge is used to create a set of documents, such as birthday invitation that is sent to many friends and 

relatives or a sheet of address labels.
	 	 Presentation software such as MS-PowerPoint 2007 allows users to create slide shows that can be viewed on 

the computer or projected onto a large screen.
	 	 Spreadsheet software such as MS-Excel 2007 can be used for both simple and complex calculations.
	 	 Desktop publishing software such as MS-Publisher 2007 is designed specifically to handle various desktop 

publishing needs of individuals and small organization.
	 	 Database software such as MS-Access 2007 is designed to keep track of information.

Review Questions
Fill in the Blanks
	 1.	 ...................................... is the software that is designed to satisfy a particular need of a particular 

environment.
	 2.	 You use ...................................... when you want to create a set of documents, such as a birthday invitation 

that is sent to many friends and relatives or a sheet of address labels.
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	 3.	 ...................................... programs are used to create professional quality documents that combine text and 
other visual elements in non-linear arrangements.

	 4.	 In a ...................................... the data is organized in the form of tables.

State Whether True or False
	 1.	 Word processing software was originally designed as a replacement for the typewriter.
	 2.	 Spreadsheet software such as MS-Excel 2007 cannot be used for both simple and complex calculations.
	 3.	 The Publisher program window displays all the tools you need to customize the publication.
	 4.	 In a database, a sub report is a report that is inserted in another report.

Multiple Choice Questions
	 1.	 ...................................... are used to create sections within a MS-Word document.
		  (a)	 Section breaks	 (b)	 Mail break	 (c)	 Slide show	 (d)	 Brochures
	 2.	 In MS-PowerPoint 2007, clicking Slide Show button in View area on Status bar will 
		  (a)	 Save Presentation	(b)	 Print Presentation	(c)	 Run Presentation	 (d)	 Check Spelling
	 3.	 In MS-Excel, you can create If condition using
		  (a)	 AND	 (b)	 OR	 (c)	 Both (a) and (b)	 (d)	 None of these
	 4.	 How many database(s) can be open at a time in MS-Access 2007?
		  (a)	 Any number	 (b)	 Three	 (c)	 Two	 (d)	 One 

Match the Following

			   Column A		  Column B

	 1.	 Document creation	 (a)	

	 2.	 Financial calculation	 (b)	

	 3.	 Database management	 (c)	

	 4.	 Present information	 (d)	

	 5.	 Desktop publishing	 (e)	

Answer the Following
	 1.	 What is word processing? Describe mail merge in Word 2007.
	 2.	 Give the steps to insert an image or clipart in a presentation in PowerPoint 2007.
	 3.	 What is spreadsheet? Describe IF condition with AND or OR in Excel 2007.
	 4.	 Name some publications that you can publish with Publisher 2007. Give the steps to  create and save a 

publication based on a template.
	 5.	 Describe main/subreport in Access 2007.

Suggested Activities
	 1.	 Use the correct software tool and enhance the knowledge of IT at the same time as the chosen subject.
	 2.	 Use appropriate software tools e.g., spreadsheet package to solve a mathematical problem.

Field Trip
	 Using the Internet or computer magazines, look up information on Microsoft Office 2010. List any features 

you find. List which of these features appeal to you and describe why they do.
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BASIC 
TROUBLESHOOTING

   Unit Outcome
	 Students will be able to:

	 	 recognise  basic idea in preventive maintenance;

	 	 apply the knowledge gained in preventive maintenance to prolong the life of the computer;

	 	 be aware of basic safety issues;

	 	 recognise major hardware components inside the computer;

	 	 acquire knowledge on how to format hard disk and install software.

3.1 BASICS OF PREVENTIVE MAINTENANCE

You have already studied about computers and their applications in Grades 9 and 10. Computers play an 
important role in our lives. Generally computers are built to be professional, reliable machines. A computer 
may hang; send error messages, or worse, no longer work at all. For computer users, troubleshooting 
problems can stop their work. If you know how to troubleshoot problems related to a computer, you can 
save hundreds or even thousands of Birrs.

l Environment and Location of a Computer
Computer is a very sensitive device and needs to be placed very carefully. Its physical environment and 
location requires some special arrangements, protections and precautions (see Fig. 3.1). These precautions 
and protections are not only necessary for computers but are equally important for computer users. 

	                       

	 A Desktop Computer	 A Laptop
Fig. 3.1: Proper environment and location are very important for any computer

	 In order to ensure trouble free, prolonged life and smooth working of any computer, you must take into 
consideration that dust-free environment and proper location are maintained for it. You must take care of 
the following:
	 (i)	 Always place your computer in an open area that allows adequate airflow.
	 (ii)	 Keep the computer in a cool, dry and dust-free environment.

Unit 3   
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	 (iii)	 Keep level, stable floors and tables.
	 (iv)	 Arrange ergonomic furniture.
	 (v)	 Keep precautionary fire prevention equipment.
	 (vi)	 Must have static electricity.
	 (vii)	 Keep the computer safe from vibrations.

	 Useful Tip
Keep it Cool

Do not restrict the airflow around your computer. Always avoid putting your computer in an area with a lot 
of dust and do not stack papers, books or other items on or around your computer.

l Electric Power
Computers need electric power to work, but it can harm a PC or its data if it does not flow properly. 
The electricity available from a standard wall outlet is Alternating Current (AC), but a PC runs on Direct 
Current (DC). The power supply is a device that converts AC to DC to run the computer. The on/off switch 
in your computer turns on or shuts off the electricity to the power supply.
	 Your computer needs good power to run properly, but various factors can take what should be a steady 
stream of electricity from the wall socket and turn it into a trickle or a fire hose. It is important that you 
know how to protect your computing environment from electrical power sags and power losses, power 
spikes, lightning strikes, and electromagnetic interference.
	 Let us understand some of the causes of power problems.
	 A brownout occurs when the supply of electricity drops dramatically but does not go out completely. 
During a brownout, you will notice lights flickering or growing dim. When the power rises back up to its 
original level, your computer might not be able to handle the drastic change and damage may occur.
	 Blackouts occur when power goes out completely. The danger of a blackout is twofold. First, you may 
have data loss or corruption when the power goes out. Second, your PC may receive electrical damage 
from the power surge when the electricity comes back on.
	 Power spikes or power surges occur when the voltage on your power line rises suddenly to above-normal 
levels, Power spikes are extremely dangerous and can destroy PCs, monitors, and any other component 
plugged into the affected power line.
	 Lightning storms are an underrated hazard. Using a computer or even leaving it plugged in during a 
lightning storm is asking for trouble. Keep in mind that no accessory can completely protect your PC from 
the damage caused by a lightning strike.
	 All electrical equipment puts out a certain amount of electrical noise caused by the signal running 
through wires, cables, and circuits. Electromagnetic interference (EMI) occurs when two signals get too close 
together and the noise of one is picked up by the other. In computers and networking, this can cause 
problems, such as wavy screens or slow or corrupted data transfers. Long cable runs tend to pick up EMI, 
especially if a power cable is running alongside a data cable.
	 Instead of plugging your computer directly into the wall electrical outlet, it is a good idea to plug it 
into a power protection device such as surge protector, voltage regulator, UPS (Uninterruptible Power 
Supply).
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l Backup Methods
Every computer user must backup the files stored in the computer. If you backup your files, you can 
restore files in the event of a hard disk crash. Backing up files represents a significant investment of time 
and effort. At the same time, all computer files are potentially easy to change or erase, either intentionally 
or by accident. 
	 There are different methods for backing up data stored in files. Some of the best and most secure 
methods are:
	 (i)	 External hard drives: External hard drives are the most reliable, simplest, and most affordable 

method of backup for computer users. They are gradually increasing in size and reliability, and 
many now come with software that can be used to backup your data regularly and perfectly.

	 (ii)	 Flash drives/USB thumb drives: If you do not have a massive amount of data to backup, a portable 
flash drive is a great backup method. Flash media is extremely hard to break, very reliable, and 
modern thumb drives can hold upwards of three or four GB of information.

	 (iii)	 Remote data storage via the Internet: Some companies offer services with small monthly fees for 
online data storage. The advantages to these services are of great importance; your data is encrypted, 
so it is kept very safe. Since it is not in your physical location, if there is any natural disaster, your 
files are still fine. If your data is extremely important and you want to keep it safe, remote data 
storage might be your preferred method of backup.

	 (iv)	 CD/DVD-ROMs: These days, nearly every computer has a DVD-ROM drive that can write large 
amounts of information relatively quickly to either a DVD-R or CD-R disk. The disks themselves are 
relatively inexpensive, and they are a great form of data backup, as long as they are kept properly 
labeled and checked for consistency.

	 So, good backup habits are a very important part of computer repair and can leave you with some 
much-deserved peace of mind.

	 1.	 Data backup is an important part of computer maintenance.
	 2.	 When choosing a backup method, look at cost and reliability.
	 3.	 Be sure to develop data backup habits in order to avoid costly recovery.

l Manual
Personal computers are expensive appliances, and risk being damaged from several sources: viruses, electric 
power disturbances, and human error.  As such, it makes sense to take routine precautionary measures.
	 (i)	 Update anti-virus program: A computer virus can potentially wipe out all of the information stored 

on your computer.  New viruses are constantly being created, and your protection is only as good 
as your last anti-virus update.

	 (ii)	 Back-up hard drive: Creating a back-up of the important files on your hard drive helps and assures 
you that you will have a safe copy available of your important information incase anything happens 
to damage or compromise your hard drive.

	 (iii)	 Test electrical surge protector:  A properly maintained surge detector can prevent major damage to 
your personal computer.



Unit 3 – Basic Troubleshooting

56	  	 Information Communication Technology — Grade 11 Student Textbook

l Using Utility Programs
Utility programs, also called service programs, perform tasks related to the control and allocation of 
computer resources. They enhance existing functions or provide services not supplied by other system 
software programs. The utility programs can perform the following tasks:
	 (i)	 Backup: There is always a possibility that the hard-disk drive fails and you have no more programs 

or files to use. A backup utility is used to make a backup, or duplicate copy, of the information on 
the hard disk. For example, Norton Backup and Colorado Schedular.

	 (ii)	 Data-recovery: A data-recovery utility is used to restore data that has been physically damaged or 
corrupted. Data can be damaged by viruses, bad software, hardware failure, and power fluctuations 
that occur while data is being written/recorded.

	 (iii)	 Virus protection: A virus consists of hidden programming instructions that are buried within an 
application or system program. Viruses are spread when people exchange floppy disks, download 
(make copies of) information from the Internet and other computer networks, or open the files 
attached to e-mail.

		  To protect viruses, you must install antivirus software. Antivirus software is a utility program that 
scans hard disks, floppy disks, and memory to detect viruses. Some utilities destroy the virus on 
the spot. Others notify you of possible viral behaviour. As new viruses are constantly being created, 
you need the type of antivirus software for detecting the unknown viruses. For example, Norton 
Antivirus, McAfee’s Virus Scan, etc.

	 (iv)	 Data compression: As you keep on storing files on the hard disk, it will eventually fill up. You can 
either delete old files to make room for the new or you can use a data compression utility, such as 
PK Zip or StuffIt.

		  Data compression utilities remove redundant elements, gaps, and unnecessary data from a computer’s 
storage space so that less space (fewer bits) is required to store or transmit data.

l Improving Hard Disk Performance
With the passage of time the hard disk of a computer 
normally gets cluttered with lot of data. This makes it 
slower to read data off the hard disk. This is because the 
files are sometimes scattered across different parts of the 
hard disk, and it takes more time to access all the parts. 
Figure 3.2 shows a hard disk. 
	 The following steps will help you in cleaning your hard 
disk from all the junk that it might have accumulated, and 
to improve hard disk performance:
	 (i)	 Remove duplicate files from hard disk.
	 (ii)	 Remove temporary files.
	 (iii)	 Hive off the non-essential files.
	 (a)	 Find large files occupying your disk space.
	 (b)	 Store all these files online.
	 (iv)	  Defragment hard disk.
	 (v)	  Detect and repair disk errors.
	 These steps will free up lot of space from the hard disk, and will improve hard disk performance.

Fig. 3.2: A Hard Disk
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	 Useful Tip
Data Recovery

Is your hard disk crashed? Try these
	 (i)	 www.driversavers.com	 (ii)	 www.drivelabs.com	 (iii)	 www.harddriverecovery.org

l Disk Defragmenter
When you delete old files from your hard disk and add new ones, 
something happens: The files become fragmented. Fragmentation is 
the scattering of portions of files about the disk in nonadjacent areas, thus 
greatly slowing access to the files.
	 When a hard disk is new, the operating system puts files on the 
disk contiguously (next to one another). However, as you update a 
file over time, new data for that file is distributed to unused spaces. 
These spaces may not be contiguous to the older data in that file. 
It takes the operating system longer to read these fragmented files. 
A defragmenter utility program, commonly called a “defragger,” will find 
all the scattered files on your hard disk and reorganize them as contiguous 
files. Deframenting the files will speed up the drive’s operation. 
Figure 3.3 shows disk defragmentation.

l Disk Cleanup
The disk cleanup utilities can search for and remove unnecessary files, such as temporary files, or “temp 
files”. Both Windows and the applications you run create 
temp files needed only for short tasks and system restore 
(return to normal operating conditions) after certain types of 
system problems. These files are stored in the Temp folder. 
For example, when you create a word document, Word will 
store a temp file version of it in the Temp folder. When you 
save this document, Word will save it to the location you 
designated and delete the temp file. The computer should 
delete temp files when a program is closed, but this does not 
always happen. Also, files will be left in the Temp folder if 
the computer crashes. Thus temp files can accumulate in the 
Temp folder and take up space.
	 In Windows XP, run Disk Cleanup to determine how 
much hard disk space you can free up (see Fig. 3.4). Then 
choose which files to get rid of.
	 To use Windows Disk Cleanup,
	 Click Start → All Programs → Accessories → System Tools → 
Disk Cleanup

Many other utilities are available to cleanup your hard disk including CleanIt! and CleanWin. Most are 
freeware or shareware.

Fig. 3.3: Disk defragmentation

Fig. 3.4: Using Disk Cleanup



Unit 3 – Basic Troubleshooting

58	  	 Information Communication Technology — Grade 11 Student Textbook

Activity 3.1
Preventing Computer from Electrical Power Problems

The students will practise as the teacher instructs about preventing computer from electrical power 
problems.

Electrical Power and Power Supply

The electricity available from a standard wall outlet is Alternating Current (AC), but a PC runs on Direct 
Current (DC). The power supply is a device that converts AC to DC to run the computer.

Preventing Problems

Too little or too much electricity can devastate your data and computer hardware. For example, a sudden 
surge, or spike, in AC voltage can burn out the low-voltage DC circuitry in the computer.

	 Do the following things to keep your data and computer hardware safe:

	 1.	 Back up data regularly: You must make backup (duplicate) copies of your data every few minutes as you 
are working. Then, if your computer has power problems you will be able to get back in business fairly 
quickly once the machine is running again.

	 2.	 Use a surge protector to protect against too much electricity: Plug all your hardware into a surge protector 
(suppressor), which will prevent damage to your equipment if there is a power surge (see Fig. 3.5). (You 
will know you have experienced a power surge when the lights in the room suddenly get very bright.)

	 3.	 Use a voltage regulator to protect against too little electricity: Plug your computer into a voltage regulator (also 
called a line conditioner) to adjust for power sags or brownouts. If power is too low for too long, it’s as 
though the computer were turned off.

	 4.	 Use a stabilizer to ensure the level of voltage being supplied at a desired level: Plug your computer into a stabilizer 
(see Fig. 3.6) to adjust for power variations, which will deliver a consistent voltage level to the equipment. 
Power fluctuations can cause damage to electrical motors and components. This damage could be severe 
and immediate, or it could result in a shorter operating lifespan.

	 5.	 Consider using a UPS to protect against complete absence of electricity: Consider plugging your computer into a 
UPS (Uninterruptible Power Supply). The UPS is kind of a short-term battery that, when the power fails, 
will keep your computer running long enough (5–30 minutes) for you to save your data before you turn 
off the computer (see Fig. 3.7). It also acts as a surge protector.

	 	 	

	 Fig. 3.5: Surge Protector	 Fig. 3.6: Voltage Stabilizer	 Fig. 3.7: UPS
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	 6.	 Turn ON highest-power consuming hardware first: When you turn on your computer system, you should turn 
on the devices that use the most power first. This will avoid causing a power drain on smaller devices. 
The most common advice is to turn on (i) printer, (ii) other external peripherals, (iii) system unit,  
(iv) monitor—in that order.

	 7.	 Turn OFF lowest-power-consuming hardware first: When you turn off your system, follow the reverse order. This 
avoids a power surge to the smaller devices.

	 8.	 Unplug your computer system during lightning storms: Unplug all your system’s components—including phone 
lines—during thunder and lightning storms. If lightning strikes your house or the power lines, it can ruin 
your equipment.

So, you can prevent your computer from electrical power problems by following the things stated above.

3.2 Basic Safety Issues

Today the computers are an essential tool in the work of most schools and organizations all over the world. 
With the increase in computer use, a number of health and safety concerns related to vision and body 
aches and pains have arisen. Although problems can occur through their use, with the proper equipment, 
ergonomic workstation design, proper techniques and working practices, the risk of problems can be 
greatly reduced.

l Overview of Safety Measures
Whether you are having a desktop PC or a laptop computer, safety measures are most important. Some 
safety measures are:
	 (i)	 Guarding against hardware theft and loss.	 (ii)	 Guarding against heat, cold, spills and drops.
	 (iii)	 Guarding against damage to software.	 (iv)	 Protecting the data.
	 (v)	 Protecting the health.

l Electro Static Discharge (ESD)
Electro Static Discharge (ESD) is the release of static electricity when two objects come into contact. Familiar 
examples of ESD include the shock we receive when we walk across a carpet and touch a metal doorknob 
and the static electricity we feel after drying clothes in clothes dryer. A more extreme example of ESD is 
a lightning bolt. 
	 ESD is one of the few things an individual can do to damage or destroy his or her computer or hardware 
components. It can occur when working in your computer and will cause components you touch to no 
longer work properly. ESD can occur without the user feeling a shock and will only occur while working 
on the inside of the computer or handling an expansion card.

Sources of ESD
The most common sources of ESD are:
	 (i)	 Charged person: A person can become charged due to walking or other movement. ESD damage 

can be especially severe if the discharge from the person is via a metallic object, such as a tool.
	 (ii)	 A cable rubbing across carpet: If a charged cable is plugged into a conductive contact with any 

source of charge, ESD will occur.
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	 (iii)	 An electronic device sliding into or out of a bag or tube generates an electrostatic charge as the 
device’s case and/or metal leads make multiple contacts and separations with the surface of the 
container.

Preventing ESD 
ESD is one of the main enemies of your computer. The best method of preventing ESD is to use an ESD 
wrist strap or use a grounding mat or table. However, because most users do not have access to such items, the 
following steps can help in reducing the chances of ESD as much as possible:
	 (i)	 Zero Potential: Most importantly, make sure you and the computer are at zero potential by 

continuously touching an unpainted metal surface of the chassis or the computer power supply 
case.

	 (ii)	 Standing: It is also very important that you are standing at all times when working on the computer. 
Sitting on a chair can generate more electrostatic discharge.

	 (iii)	 Cords: Make sure everything is removed from the back of the computer (power cord, mouse, 
keyboard, etc).

	 (iv)	 Clothes: Make sure not to wear any clothing that conducts a lot of electrical charge, such as a 
woolen sweater.

	 (v)	 Weather: Electrical storms can increase the ESD risk; unless absolutely necessary, try not to work 
on a computer during an electrical storm.

	 (vi)	 Accessories: To help reduce ESD and help prevent other problem, it is also a good idea to remove 
all jewelry. 

Anything that protects sensitive computer equipment by preventing electrostatic discharge is termed 
as anti-static.

l Hidden ESD
Dust buildup on PC components causes hidden ESD damage. Over time, this buildup creates a small 
electrical charge. This charge is not enough to cause obvious damage, and in most cases you will not be 
aware that a problem exists until a component begins to behave erratically. By that time, it is extremely 
difficult or impossible to pinpoint the original source of the problem. Hidden ESD is a good reason to clean 
your computer regularly.

l Catastrophic ESD
Catastrophic ESD causes a computer component to fail immediately. When catastrophic ESD occurs it will 
be obvious to you, in all likelihood, you will be the one who caused it! 
	 ESD has the potential to cause a lot of damage—lightning is a well known example. Delicate electronic 
components have little chance of surviving the sudden discharge of static electricity. When the heat from 
ESD visibly melts or welds components and immediately destroys them, it’s known as a catastrophic 
ESD event. It is estimated that catastrophic ESD is to blame for 10% of all defects caused by electrostatic 
faults.
	 Catastrophic ESD causes a computer component to fail immediately. When catastrophic ESD occurs, it 
will be obvious. You can remove the component and replace it with a new one, and it most likely will not 
affect any other component.
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l Degradation 
ESD degradation occurs when the effects of ESD are cumulative. This is caused by situations where low 
levels of ESD occur repeatedly. Damage caused by ESD degradation is not immediately apparent in full 
force; instead, the effects gradually get more and more noticeable. Like hidden ESD, degradation will cause 
your components to behave erratically, and it can make the original problem hard to recognize.

l Some Common ESD Protection Devices
Any physical device that minimizes static electricity is called an antistatic device.
	 Some common ESD protection devices are given below:
	 (i)	 Antistatic wrist and ankle straps	 (ii)	 Antistatic floor mats
	 (iii)	 Antistatic bags	 (iv)	 Workbench 

l Anti-static Wrist and Ankle Straps
Anti-static wrist and ankle straps wrap around the users wrist or ankle like a 
bracelet. These have a cord or other connection coming from that bracelet that 
attaches to the device being worked on, clips onto, or plugs into. These straps 
keep the user grounded, which helps prevent electrostatic damage to the device 
being worked on. Figure 3.8 shows a wrist strap. 
	 Some examples of how a user would properly use the anti-static wrist and ankle straps are:
	 (i)	 While working on a computer you could place your wrist or ankle in the strap and attach the other 

end (often using the alligator clip) to a metal portion of the computer case.
	 (ii)	 While working with an electrostatic sensitive hardware you could place your wrist or ankle in the 

strap and plug the other end into an antistatic mat the device is 
lying on or into an antistatic workbench.

l Anti-static Mats
An anti-static mat or a grounding mat is a floor or table mat used to help 
reduce the risk of electrostatic discharge while working on a computer 
or other electrostatic sensitive device. Figure 3.9 shows a laptop being 
repaired by a technician. The blue mat under this laptop is an anti-static 
mat.

l Setting up an Ergonomic Computer and Seating
Ergonomics is the study of the interaction between people and machines. The purpose of ergonomics is to 
make working conditions and equipment safer and more efficient. It is concerned with designing hardware 
and software that is less stressful and more comfortable to use, that blends more smoothly with a person’s 
body or actions. Examples of ergonomic hardware are tilting display screens, detachable keyboards, and 
keyboards hinged in the middle to allow the users’ wrists to rest in a more natural position.
	 Whether you set up a desktop computer and never move it or have a portable PC which you move 
from place to place, you need to be careful about protecting your computer. For setting up an ergonomic 
computer, you must take care of the following:

Fig. 3.8: Anti-static wrist 
strap

Fig. 3.9: Anti-static Mat
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	 (i)	 Guarding against hardware theft and loss.
	 (ii)	 Guarding against heat, cold, spills and drops.
	 (iii)	 Guarding against damage to software.
	 (iv)	 Protecting the data.
	 More important than any computer system and (probably) any data is computer user’s health. The 
most serious effects are painful hand and wrist injuries, eyestrain and headache, and back and neck pains. 
You can avoid most of these problems, if not all, by sitting properly. Figure 3.10 shows the correct sitting 
posture.

Fig. 3.10: Correct sitting posture

Eyestrain usually arises because of improper lighting, screen glare, and long shifts staring at the screen. 
Make sure that the windows and lights do not throw a glare on the screen and that the computer is 
not framed by an uncovered window.
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3.3 Hardware Maintenance Basics

All the system components must be compatible—in other words, each brand must work with other brands. 
You will have to make sure each component comes with any necessary cables, instructions, and component-
specific software (called a driver) that makes the component run. Arrange all the components so that these 
can be put together.

l Connecting Basic Input and Output Devices with the System Unit
Let us connect the basic input and output devices with the system unit.

Monitor
Place the monitor and the system unit (the case or system cabinet) where you wish on the desk or work area 
(see Fig. 3.11).
	 Locate the monitor cable. With PC computers, the ends of the monitor cable are often blue (see 
Fig. 3.12).

	 	 	

	 Fig. 3.11: Monitor and Sysem Unit on Desk	 Fig. 3.12: Monitor Cable

	 Locate the monitor port on the back of the system unit, and on the monitor. You may have to look under 
the screen to locate the port on the monitor. These ports are also called VGA ports and are usually blue.
	 Connect the cable into the monitor port on the monitor (see Fig. 3.13). The pins on the cable fit the port 
in a specific way, so line up the cable connector and the port. Be careful not to force or bend the pins.
	 Once the pins in the cable connector are pushed into the port, turn the plastic-covered screws on each 
side of the cable to secure it to the monitor.
	 Connect the cable into the monitor port on the back of the system unit (see Fig. 3.14). Like with the 
monitor, be careful not to misalign the pins with the port. Once the pins in the cable connector are pushed 
into the port, turn the plastic-covered screws on each side of the cable to secure it to the system unit.

	 	

	 Fig. 3.13: Monitor Port Under Monitor Screen	 Fig. 3.14: Monitor Port on Back of System Unit
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Keyboard
Locate the PS/2, or keyboard port on the back of the system unit (see Fig. 3.15). Plug the cable on the end 
of the keyboard into the PS/2 port. If the keyboard has a USB connector, locate a USB port on the back of 
the system unit and connect the keyboard.

	 	

	 PS/2 and USB Ports for Keyboards	 Keyboard with PS/2 Connector

Fig. 3.15: Connecting the keyboard with the system unit

Mouse
Locate the PS/2, or mouse port on the back of the system unit (see Fig. 3.16). Plug the cable on the end of 
the mouse into the PS/2 port. If the mouse has a USB connector, locate a USB port on the back of the system 
unit and connect the mouse.

	 	

	 PS/2 and USB Ports for a Mouse	 USB Mouse

Fig. 3.16: Connecting the mouse with the system unit

Speakers
If your computer uses external speakers, locate the bank of audio ports on the 
back of the tower and connect the speakers (see Fig. 3.17). If the speakers 
are located in the monitor then these do not have to be connected.
	 The audio ports are often confusing. If your computer has color-coded 
peripherals that match the colors on the back of the computer case, then 
connecting the audio components is generally very easy. If the peripheral 
does not have a color-coded cable, then remember that the speakers will 
always go in the green port. Headphones connect to the pink port, and various 
other devices will connect to the blue port, which is the Line In port.
	 Additionally, many devices, including headphones, now come with 
USB connectors. In most computers, the USB ports are located directly above the bank of audio ports.

Fig. 3.17: Audio Ports
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Power Supply
Plug the power supply cable into the back of the system unit, and then into a surge protector power strip  
(see Fig. 3.18).

	 	

	 Fig. 3.18: Plug Power Supply Cord into System Unit and Power Supply Cable into Power Strip

	 Plug the second power supply cable into the monitor, and then into the power strip with surge protection 
(see Fig. 3.19). The power supply port may be located beneath the screen on the monitor.
	 The basic computer hardware components are  now connected (see Fig. 3.20). You might be ready to 
start working, but before you do, spend a little time arranging your workspace.

	 	

	 Fig. 3.19: Power Supply Port on Monitor	 Fig. 3.20: System unit connected with basic input and output devices

Connecting Other Devices
Once Windows is running, you can connect your printer and other devices. Printer is an 
output device that produces text and graphics on paper (see Fig. 3.21). Each printer 
and other peripherals are installed differently, so review the related instruction 
manual before connecting a device. 

l Checking a Dead System
Many problems with computer use are temporary and can be resolved by adopting simple corrective 
action. The most common computer problem is when you cannot access your system at all. When you turn 
on the power switch, nothing happens, that is, you have a dead system.
	 A checklist of troubleshooting procedures to check a dead system is given below:
	 (i)	 Try the power switch a second or third time. If nothing happens.
	 (ii)	 Check the wall outlet for power, if the outlet has power.
	 (iii)	 Check the power cord itself from wall to the computer.
	 (iv)	 Check the power supply inside the system unit.

Fig. 3.21: A printer
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	 (v)	 Replace the power supply rather than trying to repair it.
	 (vi)	 If the system makes those click noises, but the screen is blank, check the monitor.
	 (vii)	 If the monitor proves to be good, check the video card, even in a new system.

l General Steps to Troubleshoot Problems
The general troubleshooting steps to help you identify your software or hardware problems are:
	 (i)	 Symptom Recognition: Recognize the symptoms of your problem. 
	 (ii)	 Symptom Elaboration: Elaborate on your problems. 
	 (iii)	 Action Plan: Develop an action plan and list all possible causes. 
	 (iv)	 Isolate Fault: Is it hardware or software. Review all possible software issues before jumping to any 

conclusions. 
	 (v)	 Repair, Functionality and Logging: Repair the problem, verify the functionality of your computer, log 

exactly what the symptoms were and what you did to correct the problem. 

l Troubleshooting Common Input and Output Devices
Computer problems related to common input and output devices can be 
upsetting, especially if you are trying to meet a deadline for work or school. 
Most problems are minor and can be easily fixed, so do not panic when these 
problems happen. Instead, work your way through some basic troubleshooting 
techniques and try to solve the problems. These are given below:
	 (i)	 Always check the cables, wires, and cords: A majority of computer problems 

are related to an issue in the cables and connections of the input and 
output devices. The easiest first step you can take to troubleshoot most 
problems is to check all related cables and connections (see Fig. 3.22).

	 (ii)	 Check the Power Button if your computer does not start.
	 (iii)	 Check for overheating. Make sure the vents in the case are not 

blocked.

3.4 Installing and uninstalling Application Software

l Installing Application Software
Carefully select and purchase any software, that is, it must be licensed.  Now you can get it onto your 
computer—install it. Software has recently become much more “user friendly” in this area. Most software will 
handle the installation steps without a lot of input from the user. 

Installing Microsoft Office Enterprise 2007
For CD or DVD installation, your manual’s directions will tell you what command starts the installation 
process. It is usually either setup.exe or install.exe. That should bring up a series of dialog boxes that will 
offer you whatever choices you can make for this software. 
	 Under Windows using a CD/DVD disk, the install process will start up automatically if your computer 
is still set to auto play CDs or DVDs. If the disk does not start up by itself, you can use the Run line from 
the Start menu to type in the command. Or open a Computer or Explorer window to the drive with the 
installation disk, find the command that starts the install, and double-click on it. 

Fig. 3.22: Check All Cables, 
Wires and Cords
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	 To install Microsoft Office Enterprise 2007, perform the following steps:
	 1.	 Start your computer.
	 2.	 Insert the Microsoft Office Enterprise 2007 CD in your computer’s CD-Rom drive.
	 3.	 Double click on setup.exe to start the installation process.
	 4.	 Type your 25-character Product Key that comes with your Microsoft Office 2007 CD or written on 

the cover of CD and then click Continue (see Fig. 3.23). Here, the 25-character product key has not 
been shown due to security reasons.

Fig. 3.23: Entering Product Key

	 5.	 Software license window box appears. Accept the terms of this agreement by clicking on it. Click 
on Continue (see Fig. 3.24).

Fig. 3.24: Accepting the License Agreement 
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	 6.	 Click on Install Now button (see Fig. 3.25).

Fig. 3.25: Clicking Install Now

	 7.	 Microsoft Office 2007 installing process will start. Figure 3.26 shows the installation process in 
progress.

Fig. 3.26: Installation process in progress

	 8.	 After few minutes a dialog box will appear showing the message of successful completion of the 
installation. Click Close (see Fig. 3.27).

Fig. 3.27: Clicking Close after successful installation

	 Now, you can use the installed Microsoft Office Enterprise 2007 programs on your system.
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l Uninstalling an Application Software

There are several reasons why you may want to uninstall software from your computer. It could be that the 
software is no longer being used and is unnecessary, it conflicts with other programs, it is not functioning 
as expected or you just want to free up some space on your computer’s hard drive. Whatever the reason, 
we can uninstall a software.

Uninstalling Microsoft Office Enterprise 2007

To uninstall Microsoft Office 2007, perform the following steps:

	 1.	 Click Start → Control Panel.

	 2.	 Open the Add and Remove Programs dialog box in Control Panel.

	 3.	 Select the desired application which you want to uninstall. Here, we select Microsoft Office Enterprise 
2007. Click Remove button (see Fig. 3.28).

Fig. 3.28: Clicking Remove

	 4.	 Click OK button to confirm the removal of Microsoft Office Enterprise 2007.
	 5.	 Uninstalling process will start (see Fig. 3.29).
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Fig. 3.29: Uninstallation process in progress

	 6.	 After few minutes, Microsoft Office Enterprise 2007 will be successfully uninstalled.  Click Close 
button to close the uninstallation process (see Fig. 3.30).

Fig. 3.30: Clicking Close after successful uninstallation

	 7.	 After completion of setup, you may be asked for rebooting the system. Click Yes to reboot the 
system (see Fig. 3.31).

Fig. 3.31: Clicking Yes to reboot the system

	   Key Concepts
	 	 Computer is a very sensitive device and needs to be placed very carefully and its physical environment and 

location requires some special arrangements, protections and precautions.
	 	 A backup utility is used to make a backup, or duplicate copy, of the information on the hard disk. Use 

defragmenter and disk cleanup to improve hard disk performances.
	 	 Electro Static Discharge (ESD) is the release of static electricity when two objects come into contact. The best 

method of preventing ESD is to use anti-static wrist and ankle straps, or use a grounding mat or table.
	 	 Eyestrain usually arise because of improper lighting, screen glare, and long shifts starting at the screen.
	 	 We must know how to plug properly input and output devices with a system and their troubleshooting.

	 	 We must know how to install and uninstall application software.
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Review Questions
Fill in the Blanks

 	 1.	 ...................................... is a very sensitive device and needs to be placed very carefully.

	 2.	 ...................................... is the release of static electricity when two objects come into contact.

	 3.	 A computer user must know how to plug properly ............................. and .................................devices with 
the system unit.

	 4.	 ...................................... is the study of interaction between people and machines.

State Whether True or False
	 1.	 Utility programs do not perform tasks related to the control and allocation of computer resources.
	 2.	 If you back up your files, you can restore files in the event of a hard disk crash.
	 3.	 A majority of computer problems are related to an issue in the cables and connections. 
	 4.	 How to install and uninstall application software are not important to learn.

Multiple Choice Questions
	 1.	 Which of the following is/are backup method(s)?
		  (a)	 External hard drives		  (b)	 Flash drives/USB thumb drives
		  (c)	 Remote data storage via the Internet	 (d)	 All of these

	 2.	 ...................................... is the scattering of portions of files about the disk in nonadjacent areas, thus greatly 
slowing access to the files.

		  (a)	 Fragmentation			   (b)	 Electric Power
		  (c)	 Disk Cleanup			   (d)	 Surge Protector
	 3.	 Which of the following is not a source of Electro Static Discharge (ESD)?
		  (a)	 Charged person	
		  (b)	 A cable rubbing across carpet
		  (c)	 An electronic device sliding into or out of a bag or tube
		  (d)	 Anti-static  wrist strap
	 4.	 When you turn on the power switch of a computer and nothing happens, that is, you have  

a/an ...................................... .
		  (a)	 Booted  system 			   (b)	 Dead system

		  (c)	 Working system		  	 (d)	 Online system

Match the Following

Column A Column B

1. Power Supply (a) Utility Program

2. Norton Backup (b) ESD protection device

3. Catastrophic ESD (c) Converts AC to DC

4. Anti-static Ankle Strap (d) Causes a computer component to fail immediately.
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Answer the Following
	 1.	 How will you identify proper location for a computer and protect it from harm and damage?
	 2.	 Explain possible problems that may occur with power supply and the use of stabilizers and UPS.
	 3.	 Discuss the use of defragmenter and disk cleanup to improve hard disk performance.
	 4.	 Explain the concept of ergonomically correct computer and seating.
	 5.	 Give the steps to install and uninstall an application software.

Suggested Activities
	 1.	 Practice as the teacher instructs about the following:
	 (a)	Backup methods.
	 (b)	Using utility programs.
	 (c)	 Improving hard disk performance.
	 (d)	Disk defragmenter.
	 (e)	Disk cleanup.
	 2.	 Explain the concept of safety precautions, ESD and its effects.
	 3.	 Explain and demonstrate ESD protection devices and an ergonomically correct computer.
	 4.	 Explain the basic steps to follow while troubleshooting problems.
	 5.	 Explain and demonstrate how to install and uninstall an application software.

Field Trip
Visit some nearby educational institutions and business houses to prepare a report on basic 
troubleshooting.
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EXPLOITING THE 
INTERNET

   Unit Outcome
	 Students will be able to:

	 	 find specific information on the worldwide web in the form of text, images or sound required to solve 
a problem;

	 	 develop an awareness of web developments in making information available in different formats.

4.1 Advanced Searching

You have already learnt the basics of web and web searching in Grades 9 and 10. When you use a keyword 
or a connector to search for a topic, you are using a piece of software known as a search engine. Internet 
search engines are extremely useful tools—but the results you get back are often extremely numerous and 
sometimes irrelevant. 

	 Boolean Searching: Boolean searching is built on a method of symbolic logic developed by George Boole, 
a 19th century English mathematician. Most search engines support Boolean searches. Boolean search 
techniques can be used to carry out effective searches, cutting out many unrelated documents. 

	 For web searching you must be specific. Remember that nearly all search engines have an advanced 
search option. Do not be afraid to make use of these as they tend to list the various options you have for 
making your search more specific. For example, the search engines Google and Yahoo provide advanced web 
searching methods. 

	 To open Google Advanced Search form, click on the Advanced search hyperlink on the right side of the 
Google Search box at www.google.com.

	 Now, you can use the Google Advanced Search form for advanced searching (see Fig. 4.1). Type the desired 
search topic and press  button, your advanced search will appear on the screen.

Unit 4   
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Fig. 4.1: Google Advanced Search form

	 To open Yahoo Advanced Web Search page go to www.yahoo.com, click the down arrow in More option 
above the Yahoo Web Search box, then from the menu that appears click the Advanced Search hyperlink. 
	 Now, you can use the options on the Yahoo Advanced Web Search page to create a very specific search  
(see Fig. 4.2). Just fill in the fields you need for your current search and click the  button, 
your advanced search will appear on the screen.

Fig. 4.2: Yahoo Advanced Web Search page
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l Exact Match
If you want to search for exact match then use phrases with quotation marks rather than separate 
words. The search returns documents containing the exact phrase only. For example, typing “Ethiopian 
music”, though the Advanced Search screen will nearly always give a specific box for phrase searching  
(see Fig 4.3).

Fig. 4.3: Using Google Advanced Search for exact match

	 Google always uses the order and the fact that the words are together as a very strong signal and will 
stray (drift) from it only for a good reason, so quotes are usually unnecessary. By insisting on phrase search 
you might be missing good results accidentally. For example, a search for [“Alexander Bell”] (with quotes) 
will miss the pages that refer to Alexander G. Bell.
	 Let us use the Boolean operators OR and AND for advanced searching of the web:

l “x” or “y”
If you want to broaden your search to find documents that contain either of the keywords, use the OR 
operator between words. This is very useful when searching for terms that have synonyms. For example, 
“Ethiopian” OR “music”.

l “x” and “y”
If you want a document that contains all of your keywords, use the capitalized word AND between 
keywords. The search engine will only find documents that have both words. For example, “Ethiopian” 
AND “music”.

l “x” but “y”
When you use BUT between two keywords, the stress is given for searching the first keyword without 
ignoring the second keyword. For example, “Ethiopian” BUT “music”. 
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	 Type Ethiopian BUT music in the Advanced Web Search page of Yahoo to get the search results  
(see Fig. 4.4).

Fig. 4.4: Showing the search results after using BUT on Yahoo Advanced Search page

l Language Limitations
You have used the “advanced search” pages of Google and Yahoo search engines. Here, a searcher can 
define the search results in many ways beyond the simpler keyword search found on the front page search 
at these search engines. For example, Google and Yahoo advanced webpage search lets searchers select a 
combination of different search limitations, such as language limitations. 
	 Figure 4.5 shows the Languages option to limit the searching using Yahoo search engine.

Fig. 4.5: Yahoo language limitations on web searching

Searching the Internet effectively is a skill that comes with experience.
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4.2 Using Wikis, Blogs and Podcasts

In this sub-unit, we will learn about using wikis, blogs and podcasts.

l Wikis
Wikis are Webpages that can be viewed and modified by anyone with a Web browser and Internet 
access.
	 A wiki is a website that allows the creation and editing of any number of interlinked webpages via a 
web browser using a simplified markup language or a WYSIWYG text editor. Wikis are typically powered 
by wiki software and are often used to create collaborative works. For example, community websites, 
corporate intranets, knowledge management systems, and note services. The software can also be used for 
personal note taking. 
	 Some examples of wikis are:
	 (i)	 Wikipedia	
	 (ii)	 Wiki about Wikis 
	 (iii)	 Classroom Wikis
	 (iv)	 Teachers First Guide to Making a Successful Wiki

Advantages

Some advantages of using a wiki are:
	 (i)	 Anyone can edit.
	 (ii)	 Easy to use and learn. 
	 (iii)	 Wikis are instantaneous so there is no need to wait for a publisher to create a new edition or update 

information. 
	 (iv)	 People located in different parts of the world can work on the same document. 
	 (v)	 The wiki software keeps track of every edit made and it is a simple process to revert back to a 

previous version of an article. 
	 (vi)	 Widens access to the power of web publishing to non-technical users. 
	 (vii)	 The wiki has no predetermined structure—consequently it is a flexible tool which can be used for 

a wide range of applications. 
	 (viii)	 There is a wide range of open source software wiki has to choose from so licensing costs should not 

be a barrier to installing an institutional wiki. 

Disadvantages 

Some disadvantages of using a wiki are: 
	 (i)	 It can get messy, especially in big projects where a large number of people contribute.
	 (ii)	 It requires some maintenance otherwise it will become unstable.
	 (iii)	 The content management system is not good.
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l Blogs
Many users of the Internet have fun keeping journals, or web logs—called blogs for short, accessible to users. 
Blogs are often updated daily and reflect the personality and views of a blogger. Blog sites—for example, 
blogging network (www.bloggingnetwork.com) and Pyra Labs (www.blogger.com)—provide information about 
how you can create and maintain your own web log for a small fee. Figure 4.6 shows the Google blog.

Fig. 4.6: Google blog

	 Some examples of blogs related to Ethiopia are:
	 (i)	 www.bottomlysandethiopia.blogspot.com	 (ii)	 journeytonumberthree.blogspot.com
	 (iii)	 theeyesofmyeyesareopened.blogspot.com	 (iv)	 www.colefamilyadventure.blogspot.com

Advantages
Some advantages of blogs are:
	 (i)	 Blog sites can be developed with the help of simple procedures. 
	 (ii)	 A blog post goes public, in other words, it can be accessed and read by almost everyone who has 

an access to Internet. 
	 (iii)	 The usage of blogs are very convenient, hence people tend to use them more frequently. 
	 (iv)	 Students tend to improve their writing skills as blog articles should be reasonably good enough and 

free from grammatical mistakes. 
	 (v)	 Students get into the habit of writing, which helps them in all their future endeavours. 
	 (vi)	 Blog sites used as online class forums enable students to interact with various personalities to 

participate in a discussion far more effectively than they can otherwise. 
	 (vii)	 Individuals learn to express their opinions and exchange their views on topics of common interest, 

which not only keeps them updated but also makes them effective contributors of new ideas. 
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	 (viii)	 Individuals get a chance to read other blogs, which indirectly helps them to improve upon their skill 
of writing. 

	 (ix)	 Instructors of online classes get an opportunity to know what students feel about the class and its 
presentation quality and help to find ways to improve upon drawbacks if any. 

	 (x)	 It is a place for students and individuals to share their articles and opinions with people outside 
their community.

Disadvantages 
Some disadvantages of blogs are: 

	 (i)	 It involves a lot of time to update and post an entry on the blog site.

	 (ii)	 Regular writing may give rise to slangs and sloppy way of writing, spoiling the quality of proper 
usage of language.

	 (iii)	 One major drawback is that not all information can be shared on blog sites. Hence, it may not be 
useful for everyone.

	 (iv)	 Individuals and students may have reluctance is getting used to the technological advancements.

	 (v)	 Blogging cannot be thrusted upon students who are hardly interested in reading and replying to 
the post.

	 (vi)	 Blogging on day-to-day issues is different from writing on a subject. Hence it may not be a practical 
idea to force students to do it.

	 (vii)	 There is no confidentiality as it is a public forum.

	 (viii)	 It is not suited for issues requiring immediate solution.

	 (ix)	 Blogs create a sense of students competing with each other just for posting entries. The fear of 
students getting diverted away from the subject is an issue of concern.

In a search engine, type the word blog or the words web log and the name and a topic of your interest 
to read the bloggers’ views about it.

l Podcasts
Podcasts are online broadcasts that you can download to portable devices. It is a piece of audio (usually an 
MP3 file) that can be automatically delivered to your computer, for you to listen to at your convenience. It 
might be a professional radio programme, a film review, a language lesson, a daily recipe. Whatever your 
interests, you are likely to find a podcast to fit the bill.
	 Podcasting lets you automatically receive the latest episode of your chosen programme as soon as it is 
available. With our current range of audio podcasts, you can take your favourite radio programmes with 
you on the move and listen wherever and whenever you like.
	 You can “subscribe” to receive a podcast, rather like you might subscribe to a magazine and get it 
delivered each week. For example, all of the BBC’s podcasts are free, and you can stop receiving the files 
at any time (see Fig. 4.7). If you would rather not subscribe, you can download episodes of a podcast series 
individually.
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Fig. 4.7: BBC podcasts

	 In order to subscribe for a podcast, you need an Internet connection and a piece of podcast software 
which is usually available free of charge. Once you have installed this software, it will check the podcast 
for new episodes of your chosen podcast series and automatically download new episodes for you.

	 You can then listen to podcast episodes on your computer, or transfer them to a portable device, such 
as an MP3 player.

Advantages

Some advantages of podcasts are:

	 (i)	 Available anytime/anywhere for students.

	 (ii)	 Easy to create, distribute, and download—no professional equipment is required.

	 (iii)	 New podcasts are auto-downloaded.

	 (iv)	 Can restrict podcasts to students enrolled in the course.
	 (v)	 Power of audio over text—students can listen and learn while walking, riding, waiting in line, etc.

Disadvantages 

Some disadvantages of podcasts are: 
	 (i)	 Entire file is downloaded to user’s computer/device.
	 (ii)	 Need sufficient bandwidth to download the podcasts in a timely fashion.
	 (iii)	 Limited usefulness for hearing impaired people.
	 (iv)	 No interactivity—audience cannot participate, etc.
	 (v)	 Intellectual property issues.
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Activity 4.1
Visiting a Wiki, e.g., Wikipedia

In small groups, the students will visit a wiki, e.g., Wikipedia.

	 To visit Wikipedia, perform the following steps:

	 1.	 Connect to the Internet.

	 2.	 Type www.wikipedia.org in the URL bar of the browser and press the Enter key.

	 3.	 The Wikipedia home page appears. Type a topic you want to learn in the search box (see Fig. 4.8)

Fig. 4.8: Wikipedia home page

	 Now you can search and use the contents available on Wikipedia for learning the topic of your choice  
(see Fig. 4.9). 

Fig. 4.9: Using Wikipedia contents

Wikipedia is the free encyclopedia that anyone can edit.
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4.3 Social Networking

A case study is a detailed, in-depth study about a person, small group, or situation. Let us analyze the case 
study given below:

Case Study
Social Networking—A Need of Social Life

Nigatu moved from Gonder to a new locality in Addis Ababa three months back. After spending whole day in 
the office when he used to come back home he felt lonely and started missing his old pals and family. Like all 
other human beings he also needed a social life so that after office he could relax and interact with buddies.

	 One day one of his colleagues suggested him to go to a club in his area where he can find people with varied 
interests. On his colleague’s advice Nigatu went to the club. There he found a group of people playing snooker, 
another group just gossiping and chatting and yet another group involved in various other activities. Nigatu has 
always been a good player of chess so he headed towards that group and became a part of it. And now he is 
very happy and does not feel lonely. Also he has found the contact number of one of his school time friend 
whom one of the club members knows, so now he in touch with him also.

	 	

	 Fig. 4.10: Nigatu sitting alone after moving to a new place	 Fig. 4.11: Nigatu enjoying social life with friends

	 A common activity just brings two people together but afterwards they share all their thoughts, happiness 
and sorrows. In today’s life people are so occupied that they hardly get time to go to a club but they also 
need a social circle and since most of the time they are online so nothing like having a friends group available 
on computer only. And social networking sites on Internet provide a platform for this. For example, Facebook, 
Orkut, etc.

	 Social networking is the grouping of individuals or organizations into specific groups. Although social 
networking is possible in person, especially in the workplace, universities, and high schools, it is most 
popular online. This means that although you are in Ethiopia, you could develop an online friendship with 
someone in India or USA.
	 Initially social networking was an initiative to communicate amongst known and unknown users 
working over network worldwide. It has now turned into a much matured area to explore and exploit 
experiences and experties of individuals sitting miles and miles away from each other. It gives a common 
platform to find people of varied interests and social backgrounds. A number of people utilize the services 
of social networking sites as a common place to develop group projects on various subjects. It also helps to 
find out alumni and old friends and also allows you to contact and start fresh conversations. It creates an 
extended network by connecting friends of friends and further enabling the empowerment of knowledge 
and resources. The social networking websites are known as social sites. Some of the common social 
networking sites are Facebook, Twitter, Netlog, Hi5, Orkut, etc.
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	 Figure 4.12 shows people connected on Facebook (Courtesy: www.NewsDire.com).

Fig. 4.12: People connected on Facebook

	 As mentioned earlier, social networking often involves grouping specific individuals or organizations 
together. While there are a number of social networking websites that focus on particular interests, there 
are others that do not. The websites without a main focus are often referred to as “traditional” social 
networking websites and usually have open memberships. This means that anyone can become a member, 
no matter what his hobbies, beliefs, or views are. However, once you are inside this online community, 
you can begin to create your own network of friends and eliminate members that do not share common 
interests or goals.
	 Although the idea of online social networking sounds very useful but there is certain element of risk 
and danger involved in it. Through networking you not only communicate with your known ones but also 
to strangers and revealing your personal details to strangers can sometimes be very dangerous. Sometimes 
a stranger may  pretend to be someone which he is not in reality. But then this type of risk is involved in 
real world too. Everyday, for the business purpose or otherwise, one has to meet and interact with many 
unknown people. In such situations we use our wisdom to calculate how much of ourselves to reveal 
before him. Similarly, while interacting online, one should use his inner voice to react accordingly. The 
other type of risk involved in social networking is hacking. Even if you are interacting with known people, 
your information and personal details can be hacked by hackers. So one has to be cautious and supply only 
minimum required details.
	 There are some common threats pertaining to these sites which are shared along with the precautions 
below:
	 (i)	 Threat: Unknown users on Internet can misuse your personal information disclosed by you on your 

account.
		  Precaution: Do not reveal personal information to strangers. Have restricted and brief conversations 

only.
	 (ii)	 Threat: A lot of abusive and unwanted content may be present on such social networking sites.
		  Precaution: All the service providers of such sites are very proactive and careful about such things. 

So as an ethical user you should report it to the service provider immediately.*
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	 (iii)	 Threat: Fake identity of someone known to you or someone famous.
		  Precaution: As soon as you come across a user with a fake identity on such sites, you should 

immediately report about the same to service provider.*

Precautions marked by * are taken very seriously and acted upon by service providers.

	 Once you are well informed and comfortable with your findings, you can begin your search from 
hundreds of networking communities to join. This can easily be done by performing a standard Internet 
search. Your search will likely return a number of results, including MySpace, FriendWise, FriendFinder, 
Yahoo! 360, Facebook, Orkut, and Classmates.

4.4 Producing a Webpage using simple Web design software

Creating webpages takes a little practice, but once you are familiar to it, you will have a lot of fun. The 
first step is to decide what you want to publish on your webpage. Maybe you want to publish an original 
story you have written, share reviews of books you have read, or create an electronic magazine related to 
one of your hobbies. A web design software is required to create a webpage.
	 MS-Publisher 2007 is an excellent authoring tool to use when you want to quickly create, publish, and 
manage simple webpage.
	 To create a webpage, perform the following steps:
	 1.	 Start Publisher.
	 2.	 On the Menu bar click File and then click New. 
	 3.	 In the Publication Types list, click Web Sites. Select any web design template from the Newer Designs. 

Here we select Bounce (see Fig. 4.13).

Fig. 4.13: Selecting web design template
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	 4.	 Click Create. 
	 5.	 The Easy Web Site Builder dialog box appears (see Fig. 4.14). 

Fig. 4.14: Easy Web Site Builder dialog box

	 6.	 Click OK.
	 7.	 Add content to your publication, and make any changes that you want (see Fig. 4.15).

Fig. 4.15: Adding content to publication

Avoid placing objects on master pages in your Web publication. Objects that are placed on Publisher 
2007 master pages do not display correctly when they are viewed in some Web browsers.
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	 8.	 Click Webpage Preview in Web Tools (see Fig. 4.16) or on the File menu, click Webpage Preview.

Fig. 4.16: Clicking Webpage Preview

	 9.	 The webpage is shown in your default browser (see Fig. 4.17)

Fig. 4.17: Previewing the designed webpage in a web browser

	 10.	 Close the browser.

4.5
Publishing to a web server (or free web server or a 
Wikipedia web server)

Now you have produced a webpage using simple web design software (Publisher 2007). For publishing 
it on the web, we require a web server. Some web servers which offer free web hosting or publishing on 
the web are:
	 (i)	 crystalserve.com	 (ii)	 monkeyserve.com
	 (iii)	 www.instantfreesite.com	 (iv)	 webhostingdeluxe.com	
	 (v)	 www.redwebhost.com	 (vi)	 www.0catch.com
	 Here, we select www.0catch.com to implement the webpage.
	 To publish the webpage, perform the following steps:
	 1.	 Connect to the Internet using a browser. Here, we are using the Internet Explorer browser.
	 2.	 Type www.0catch.com in the URL. The home page of the website appears (see Fig. 4.18).
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Fig. 4.18: Home page of website www.0catch.com

	 3.	 Click SIGN UP button. Choose your site name and click Sign Up Now (see Fig. 4.19). Here, we select 
senyaali.

Fig. 4.19: Selecting Signup Options

	 4.	 Select your plan. Here, we select Free under Plan #1 (see Fig. 4.20)

Fig. 4.20: Choosing Web Plan

	 5.	 Click Continue With Signup 
	 6.	 On the next screen click on No Thanks, a FREE site will be fine.
	 7.	 Fill your Account Information and click Create Your Account (see Fig. 4.21)
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Fig. 4.21:  Filling Account Information

	 8.	 Enter your E-mail address to get special offers and click on Subscribe (if you want) otherwise No 
Thanks, Skip Offer (see Fig. 4.22).

Fig. 4.22: Choosing Special Offers

	 9.	 The website creation message will appear. It shows the URL of your website (see Fig. 4.23). Here, 
the website address is

		  http://senyaali.0catch.com or http://www.senyaali.0catch.com
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Fig. 4.23: Website conformation message

	 10.	 Click on the URL. The following page appears (see Fig. 4.24). Click on I have my web page on my hard 
drive and want to upload but don’t know how.

Fig. 4.24: Uploading the Website

	 11.	 Click File Uploader in Create/Build Your Site (see Fig. 4.25).

Fig. 4.25: Clicking File Uploader

	 12.	 Click on CLICK HERE- To use our older browser based one file at a time upload tool (see Fig. 4.26).
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Fig. 4.26: Selecting upload tool

	 13.	 Now click on Browse and select your webpage file and click Upload Files button (see Fig. 4.27).

Fig. 4.27: Uploading Webpage File

	 14.	 The upload result message appears (see Fig. 4.28).

Fig. 4.28: Upload message result

		  Now, the webpage has been successfully uploaded. Close the uploaded site.
	 15.	 In the URL bar of browser, type the address of your Webpage (here, senyaali.0catch.com) and press 

Enter key to see your webpage! (see Fig. 4.29).
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Fig. 4.29: Published webpage on the web

	   Key Concepts
	 	 Nearly all search engines have an advanced search option.

	 	 Wikis are webpages that can be viewed and modified by anyone with a web browser and Internet access.

	 	 Many users of the Internet have fun keeping journals, or web logs—called blogs for short—accessible to 
users.

	 	 Podcasts are online broadcasts that can be downloaded to portable devices.

	 	 Social networking is the grouping of individuals or organizations into specific groups.

	 	 We can produce a webpage using simple web design software and publish it to a web server.

Review Questions
Fill in the Blanks
	 1.	 Nearly all ...................................... have an advanced search option.
	 2.	 ...................................... are webpages that can be viewed and modified by anyone with a web browser 

and Internet access.
	 3.	 ...................................... are online broadcasts that you can download to portable devices.

	 4.	 Some of the social networking sites are ...................., ....................... and ........................ .

State Whether True or False
	 1.	 Boolean searching is not built on a method of symbolic logic developed by George Boole.
	 2.	 Wikis are webpages that can be viewed and modified by anyone with a web browser and Internet 

access.
	 3.	 Blogs are often updated daily and reflect the personality and views of the blogger.
	 4.	 MS-Publisher 2007 cannot be used to quickly create, publish, and manage simple webpages.
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Multiple Choice Questions
	 1.	 Which of the following search engine(s) provide advanced web searching methods? 
		  (a)	 Google	 (b)	 Yahoo	 (c)	 Both (a) and (b)	 (d)	 None of these
	 2.	 Which of the following is/are the advantage(s) of using a Wiki?
		  (a)	 Anyone can edit			   (b)	 Easy to use and learn
		  (c)	 Wikis are instantaneous	 (d)	 All of these

	 3.	 ..................................... is/are the grouping of individuals or organizations into specific groups.
		  (a)	 Social Networking			   (b)	 Standalone Computer
		  (c)	 Ideal Networking			   (d)	 All of these
	 4.	 Which of the following is/are required to create and publish a webpage?
		  (a)	 Web design software		  (b)	 Web server
		  (c)	 Both (a) and (b)			   (d)	 None of these

Match the Following

Column A Column B

1. Language Limitations (a) Social networking site

2. Blogs (b) MP3 player

3. Listen to Podcast episode (c) Fun keeping journals

4. FriendFinder (d) Allowed search limitations in advanced search

Answer the Following
	 1.	 How will you use the Boolean searching techniques? Report on improvements.
	 2.	 Explain the functions of wikis, blogs and podcasts. List the advantages and disadvantages of their use.
	 3.	 What is meant by “social networking”? Explain.
	 4.	 Give the steps to design a simple webpage using simple web design software.

Suggested Activities
	 1.	 Explore connection between Newman Hollerith and the millennium bug.
	 2.	 Set up a blog about life in your community.
	 3.	 View and listen to a podcast e.g., BBC.
	 4.	 Join a social network, e.g., Facebook, Hi5, etc.
	 5.	 Implement the webpage by selecting free web server or a wikipedia web server.

Field Trip
	 Organize a field trip to various Business Houses, Universities or Ethiopian Telecommunication Corporation 

(ETC) stations to find out and report on:
	 Wikis, Blogs, Podcasts and Social Networking.
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Image Processing 
and Multimedia 

Systems

   Unit Outcome
	 Students will be able to:

	 	 understand the concept of image processing;

	 		 differentiate image file format;

	 	 recognize the function of image processing software;

	 	 recognize interface layout of image processing software;

	 	 edit images properly using image processing software.

5.1 Overview of Image Processing

In this sub-unit, we will have an overview of image processing.

l Overview of Image Processing
An image can be the one generated by you on the computer screen or available using a scanner/camera. 
The field of digital image processing refers to processing digital images by means of a digital computer. A 
digital image is composed of a finite number of elements, each of which has a particular location and value. 
Pixel is the term used most widely to denote the elements of a digital image. Figure 5.1 shows a digital 
image in Photoshop CS5.

Fig. 5.1: A digital image

	 The fundamental steps in digital image processing are:
	 Image acquisition: It could be as simple as being given an image that is already in digital form. Generally, 
the image acquisition stage involves preprocessing, such as scaling.

Unit 5   
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	 Image enhancement: It is the process of manipulating an image so that the result is more suitable than 
the original for a specific application.
	 Image restoration: It is an area that also deals with improving the appearance of an image.
	 Color image processing: It is an area that has been gaining in importance because of the significant increase 
in the use of digital images over the Internet.
	 Wavelets: These are the foundation for representing images in various degrees of resolution.
	 Compression: It deals with techniques for reducing the storage required for saving an image, or the 
bandwidth required to transmit it.
	 Morphological processing: It deals with the tools for extracting image components that are useful in the 
representation and description of shape.
	 Segmentation: These are the procedures which partition an image into its constituent parts or objects.
	 Representation and description: These almost always follow the output of a segmentation stage, which 
usually is raw pixel data, constituting either the boundary of a region (i.e., the set of pixels separating one 
image region from another) or all the points in the region itself. 
	 Recognition: It is the process that assigns a label (e.g., “My Image”) to an object based on its descriptors.
	 Figure 5.2 shows the basic components of a typical general-purpose system used for digital image 
processing.

Fig. 5.2: Components of a general-purpose image processing system

l Definition of Image Processing
Image processing is the set of computational techniques for analyzing, enhancing, compressing, and 
reconstructing images, generally with a digital computer. 
	 Its main components are importing, in which an image is captured through scanner or digital camera; 
analysis and manipulation of the image, accomplished using various specialized software applications; and 
output (e.g., to a printer or monitor). 
	 Image processing is used in many areas, for example, astronomy, medicine, industrial robotics, and 
remote sensing by satellites.
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l Image Processing Software
Image processing software is used for organizing, retouching, and editing images that have been saved on 
CDs and DVDs, scanned in, or transferred directly from the camera to PC.  This software allows you to 
edit and crop out unwanted “strangers”, remove the red-eye effect, or put one person’s head on another 
person’s body. Some of the useful image processing software programs are: 
	 (i)	 Dxo Optics Pro	 (ii)	 MS-Paint	 (iii)	 Capture One Pro
	 (iv)	 Photo Styler	 (v)	 Bibble	 (vi)	 Photo Explosion
	 (vii)	 Picture Windows Pro	 (viii)	Picture Project	 (ix)	 Photo Editor	
	 (x)	 Photoshop 
	 Photoshop is a popular image processing software that provides numerous tools for editing an image.

Image processing software allows you to retouch photographs, adjust the contrast and the colors and 
add special effects, such as shadows.

l Image File Format
The still images in print and multimedia programs are in digital format. There are two basic forms of 
computer graphics: bitmaps and vector graphics.
	 Bitmap images are formed from a matrix of pixels with different colors. These images have large file 
sizes that are determined by the image’s dimensions in pixels and color depth. To reduce this problem, some 
graphic formats such as GIF and JPEG store the images in compressed format.
	 Vector graphics are really just a set of graphical objects such as lines, rectangles, ellipses, arcs, or curves, 
called primitives in the image. Draw programs, also called vector graphics programs, are a format widely 
used by computer-aided programs to create detailed engineering and design drawings, and have become 
popular in multimedia for 3D animation.
	 Some of the image file formats are:
	 (i)	 BMP (Bitmap)	 (ii)	 Gif (Graphics Interchange Format)
	 (iii)	 JPEG (Joint Picture Experts Group)	 (iv)	 PNG (Portable Network Graphic)
	 (v)	 TIFF (Tagged Image File Format)	 (vi)	 WMF (Windows Metafile)

Activity 5.1
List and Explain the Different File Formats GIF, JPEG, BMP and TIFF.
In small groups, the students will list and explain the different file formats GIF, JPEG, BMP and TIFF.

File Formats

We can use a variety of file formats in image processing and multimedia systems. Some of the more common 
formats are listed and explained below:

	 1.	 GIF (Graphics Interchange Format): It is pronounced “jif”, supports upto 256 colours (8 bits per pixel). 
It is a compressed format that keeps file sizes smaller. This format is widely used on the Web since files 
can be sent faster than many other formats and groups of them can be animated. Files in this format 
have the extension .gif.
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	 2.	 JPEG (Joint Picture Experts Group): It is pronounced “jay peg”. It supports 16.7 million colors (24 bits 
per pixel). The images are in compressed format so file sizes are even smaller than GIF files. Files in this 
format have the extension .jpg.

	 3.	 BMP (Bitmap): It is a standard uncompressed format for Microsoft Windows and IBM OS/2. Stores files 
as a series of dots, or pixels. It has a maximum of 16.7 million colors (24 bits per pixel) and files have 
the extension .bmp.

	 4.	 Tiff (Tagged Image File Format): It stores compressed files with a flexible number of bits per pixel. It 
provides the highest quality but has large file sizes. This format supports 16.7 million colors (24 bits per 
pixel) and files have the extension .tif.

5.2 Basics of Image Processing

In this sub-unit, we will learn the basics of image processing:

l Getting Started
As mentioned earlier, to process images you need an image processing software. Adobe Photoshop is an 
image processing software which was developed in 1990. It is a leading product in its category, which is 
used by all serious photographers and publishers. Since, 2003 Photoshop CS and new releases integrate a 
complete suite of products to create and edit images or for designing and authoring a website. Think about 
something artistic and graphical, it can do it! 
	 Among all advantages of Photoshop, it has the ability to manipulate layers, masks, contact sheets 
and blue prints, to merge them, separate images or align them with accuracy to enhance faint details or 
suppress artifacts. 
	 Here, we will use Adobe Photoshop CS5 software for image processing.

l Opening and Setting up a New document
To open Photoshop,
	 Click Start → All Programs → Adobe Photoshop CS5
	 The Photoshop opening screen will appear (see Fig. 5.3).

Fig. 5.3: Photoshop opening screen
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	 In few moments the Photoshop main screen appears (see Fig. 5.4) on which you will have to work.

Fig. 5.4: Photoshop CS5 main screen

	 The main screen displays on top a menu and an option bar (which parameters adapt dynamically 
according to your selection), a toolbox at left (including tools like selector, lasso, magic wand, paint bucker, 
eraser, brush, blur, clone, move, text, colors, etc, themselves often subdivided in several tools), and palettes 
at right (last actions, layers, colors, styles, masks, etc). In-between lies the image window. Most tools are 
associated to a shortcut key (lasso with L-key, etc).

	 Useful Tip

You can enlarge the right-hand panes by dragging the separator bar between the panes and the main content 
area.

	 To open and setup a new document, perform the following steps:
	 1.	 Click File → New. It will open the New dialog box (see Fig. 5.5).

Fig. 5.5: New dialog box
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	 2.	 Choose a desired option from Preset such as Default Photoshop Size, U.S Paper Photo, and Web etc. 
Set the Size of Preset as your need.  Here, we have selected Photo Preset and set the Photo Size to 
“Landscape 5” × 7” (see Fig. 5.6).

Fig. 5.6: Selecting Preset and Background contents

	 3.	 Click OK. It will setup the new document (see Fig. 5.7).

Fig. 5.7: A newly setup document

	 Now, you can add graphics and text in the document as per your need.
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	 1.	You can manage files with Adobe Bridge. If you are asked whether to start Bridge at login, then 
click No.

	 2.	Adobe Community Help is constantly updated. Download it, if you want.

l Creating an Image
Let us discuss some drawing tools before creating an image:
	 Brush Tool: It is used for free hand drawing and is available in the toolbar (see Fig. 5.8).

Fig. 5.8: Brush Tool

	 Horizontal Type Tool: It is used to enter the text in the image and is available in the toolbar  
(see Fig. 5.9). 

Fig. 5.9: Horizontal Type Tool

	 Rectangle Tool: It is used to draw various shapes in image and is available in the toolbar  
(see Fig. 5.10).

Fig. 5.10: Rectangle Tool

	 To create an image, perform the following steps:

	 1.	 In the recently opened new document, click on the Brush Tool.

	 2.	 Hold the mouse button on the work area and make the text or drawing you want.

	 3.	 Click on the Horizontal Type Tool button from the tool bar (see Fig. 5.11) and make a text box on the 
image area. Enter the shape text you want. 

Fig. 5.11: Text toolbar

		  You can also format the text like changing the font, Alignment of text; Size and Color of text from 
the text tool bar placed horizontally on the top of work area.
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	 4.	 Click on the Rectangle Tool button in the shape toolbar (see Fig. 5.12). 

Fig. 5.12: Shape toolbar

		  Draw the shape you want. You can also select other shapes like Round, Rectangle, Ellipse, Line and 
Custom shape from the toolbar on top of work area.

		  We have drawn the image as shown in Fig. 5.13.

Fig. 5.13: A drawn image

l Saving Image Document
To save the image document, perform the following steps:
	 1.	 Click File → Save
		    or
		  Press Ctrl + S
		  The Save As dialog box will appear.
	 2.	 Set the file type to image format such as .jpg, .bmp.
	 3.	 Type the file name and click on Save button (see Fig. 5.14).
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Fig. 5.14: Save as dialog box

	 4.	 It will open the JPEG Options dialog box. Set the Quality in Image Options and click OK  
(see Fig. 5.15).

Fig. 5.15: JPEG Options dialog box

	 The image file will be saved in the selected directory.
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l Interface Layout
The Adobe Photoshop workspace includes the command menus at the top of your screen and a variety of 
tools and panels for editing and adding elements to your image. You can also add commands and filters 
to the menus by installing a third-party software known as plug-in modules.
	 Photoshop works with bitmapped, digitized images (that is, continuous-tone images that have been 
converted into a series of small squares, or picture elements, called pixels). You can also work with vector 
graphics, which are drawings, made of smooth lines that retain their crispness when scaled. You can 
create original artwork in Photoshop, and you can import images into the program from many sources, 
such as:
	 (i)	 Photographs from a digital camera
	 (ii)	 Commercial CDs of digital images
	 (iii)	 Scans of photographs, transparencies, negatives, graphics, or other documents
	 (iv)	 Captured video images
	 (v)	 Artwork created in drawing programs
	 Figure 5.16 shows the Adobe Photoshop CS5 interface.

Fig. 5.16: Adobe Photoshop CS5 interface

	 Application bar is displayed at the top of the screen. In the Application bar are the Photoshop application 
icon, the main menu (Windows only), application controls, View controls, the workspace switcher, and a 
button to access CS Live. Below the Application bar is the Options bar, with the Tools panel on the left, 
panels, and one or more document windows that are opened separately.
	 The main menu across the bottom of the Application bar organizes commands in individual menus.
	 The Options bar displays options for the currently selected tool.
	 The document window displays the file you are working on.
	 The Tools panel contains tools for creating and editing images, artwork, page elements, and so on. 
Related tools are grouped together.



Unit 5 – Image Processing and Multimedia Systems

	 Information Communication Technology — Grade 11 Student Textbook	 	 103

	 Panels help you monitor and modify your work. An example is the Layers panel.
	 Certain panels are displayed by default, but you can add any panel by selecting it from the Window 
menu. Many panels have menus with panel-specific options. You can separate, group, stack, and dock 
panels into your preferred layout.

	 1.	Drag the panel group by the title bar, rather than by the tab.
	 2.	To demonstrate the live workspace feature, switch to My workspace and rearrange the panels. 

Then switch between Essentials and My workspace; switch to the Essentials workspace when 
finished.

l Inserting Image from a File or Other Device
We can insert image from a file or other devices such as scanner, webcam or digital camera. 
	 To insert an image from file, perform the following steps:
	 1.	 Click File → Open.
	 2.	 The  Open dialog box will appear. Select the image you want to open and click Open button  

(see Fig. 5.17).

Fig. 5.17: Open dialog box
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	 The selected image will be inserted in the document window (see Fig. 5.18).

Fig. 5.18: Inserted image from a file

	 For inserting image from other devices click File → Import → Sony Webcam. The picture will be inserted 
in the document window.

	 Useful Tip

Press Ctrl + + (Ctrl + plus sign) to zoom in and press Ctrl + – (Ctrl + minus sign) to zoom out.

5.3
Basic Image Editing (Cropping, Resizing, Correcting, 
Sharpening/Softening)

In this sub-unit, we will learn basic image editing.

l Basic Image Editing
The basic image editing techniques are useful when working with digital scans of images. We can apply 
these basic techniques in a wide variety of image editing situations.
	 The basic image editing involves the following:
	 (i)	 Adjusting tonality, the black, grey and white Levels in an image.
	 (ii)	 Adjusting the range of colors within an image, its Color Balance.
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	 (iii)	 Cropping an image, creating a new file containing only a portion of the original.
	 (iv)	 Resizing an image, creating a new file with different proportions than the original.
	 (v)	 Saving or Undoing changes you have made.

l Cropping 
Cropping is the process of removing portions of an image to create focus or strengthen the composition. 
You can crop an image using the Crop Tool and the Crop command. You can also trim pixels using the Crop 
And Straighten and the Trim commands.
	 To crop an image, perform the following steps:
	 1.	 Open the image file you want to crop and click on the Crop Tool from Tools panel (see Fig. 5.19). 

Fig. 5.19: Crop Tool

	 2.	 Click and drag the mouse button to make a crop box (see Fig. 5.20). 

Fig. 5.20: Getting ready to crop an image
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	 3.	 Press the Enter key to crop the image. The selected area of image will be cropped (see Fig. 5.21).

Fig. 5.21: A cropped image

l Resizing 
There will be times when you need to make an object bigger or smaller as you copy it from one picture 
to another.
	 To resize an image, perform the following steps:
	 1.	 Open the image file you want to resize. 
	 2.	 Click Image from the Menu bar and then select Image Size…. 
		  It will open Image Size dialog box (see Fig. 5.22). 

Fig. 5.22: Image Size dialog box
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	 3.	 Set new image size using Pixel Dimensions or Document Size and click OK.
		  The image will resize as per your entered dimensions (see Fig.  5.23)

Fig. 5.23: A resized image

l Correcting 
Adjusting proper intensity, contrast range, and color balance is very easy using image processing programs. 
Suppose, we want the color adjustment.
	 To adjust the color balance, perform the following steps:
	 1.	 Open the image file.
	 2.	 Click Image from the Menu bar → Adjustments → Color Balance.
		  It will open Color Balance dialog box (see Fig. 5.24). 

Fig. 5.24: Setting the color balance
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	 3.	 Set your desired color balance and click OK.
	 After setting color balance the image will look as shown in Fig. 5.25.

Fig. 5.25: Image after setting color balance

l Sharpening/Softening
Generally, a scanned image is not as sharp as you might wish. Sometimes you may get very sharp image. 
So, you may require sharpening/softening of the image. First of all open the document having the image 
to sharpen/soften.
	 For sharpening an image,	
	 Click Filter from the Menu bar → Sharpen.
	 The options available are: Sharpen, Sharpen Edges, Sharpen More, Smart Sharpen and Unsharp Masks.
	 Select the desired option. The image will sharpen.
	 For softening an image,
	 Click Filter from the Menu bar → Blur.
	 The options available are: Average, Blur, Blur More, Box Blur, Gaussian Blur, Lens Blur, Motion Blur, Radial 
Blur, Shape Blur, Smart Blur and Surface Blur.

	 Select the desired option. The image will soften.
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Activity 5.2
Scan a Photograph and Edit in the Desired Size and Color

Students will scan a photograph and edit in the desired size and color.

1.	 First of all, you will have to scan an image through a scanner. 

	 To scan an image in Photoshop,

	 Click File → Import → HP Scanner.

	 It will scan the image placed in the scanner and display it in document.

2.	 Now resize the image to a standard photo size (7x5) and adjust its color balance (see Fig. 5.26).

Fig. 5.26: Editing a scanned image

 3.	You can also balance the Selective Color.

	 To balance the selective color,

	 Click Image → Adjustments → Selective Color…. The Selective Color dialog box opens (see Fig. 5.27). 

Fig. 5.27: Selective Color dialog box

	 Set the color balance and click OK.
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	 After adjusting size and color, the scanned image will look as shown in Fig. 5.28.

Fig. 5.28: Image after balancing the Selective Color

4.	 To balance the Brightness/Contrast, 

	 Click Image → Adjustments → Brightness/Contrast. 

	 The Brightness/Contrast dialog box opens.

	 Set the Brightness/Contrast and click OK (see Fig. 5.29).

Fig. 5.29: Setting the Brightness/Contrast

	 The image will look as shown in Fig. 5.30.
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Fig. 5.30: Image after balancing Brightness/Contrast

	   Key Concepts
	 	 Pixel is the term used most widely to denote the elements of a digital image.

	 	 Image processing is the set of computational techniques for analyzing, enhancing, compressing, and reconstructing 
images, generally with a digital computer. 

	 	 Photoshop is a popular image processing software that provides numerous tools for editing an image.

	 	 The basic image editing techniques are useful when working with digital scans of images. We can apply these 
basic techniques in a wide variety of image editing situations.

	 	 Cropping is the process of removing portions of an image to create focus or strengthen the composition.

Review Questions
Fill in the Blanks
	 1.	 The field of ...................................... refers to processing digital images by means of a digital computer.
	 2.	 ...................................... software is used for organizing, retouching, and editing images that have been 

saved on CDs and DVDs, scanned in, or transferred directly from the camera to PC.
	 3.	 ...................................... is the process of removing portions of an image to create, focus or strengthen the 

composition.  
	 4.	 ...................................... is the process of making an object bigger or smaller.

State Whether True or False
	 1.	 Image enhancement is the process of manipulating an image so that the result is more suitable than the 

original for a specific application.
	 2.	 Adobe Photoshop is not a popular image processing software.
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	 3.	 In Photoshop, Brush Tool is used for free hand drawing and is available in the toolbar.
	 4.	 We cannot resize an image using image processing software.

Multiple Choice Questions
	 1.	 Which of the following area(s) use image processing?
		  (a)	 Astronomy	 (b)	 Medicine 	 (c)	 Industrial robotics	 (d)	 All of these
	 2.	 Which of the following image processing software can be used to retouch photographs, adjust the contrast 

and the colors and add special effects, such as shadows?
		  (a)	 Photoshop	 (b)	 MS-Paint	 (c)	 Photo Editor	 (d)	 All of these
	 3.	  Which of the following is not an image file format?
		  (a)	 GIF	 (b)	 JPEG	 (c)	 DOCX	 (d)	 TIFF
	 4.	 Which of the following is/are free hand drawing tool(s) available in Adobe Photoshop CS5?
		  (a)	 Brush Tool			   (b)	 Horizontal Type Tool
		  (c)	 Rectangle Tool			   (d)	 All of these

Match the Following

Column A Column B
1. Pixel (a) Correcting
2. Basic image editing technique (b) Basic term used most widely to denote the elements 

of a digital image
3. BMP (c) An image processing software
4. Photo Styler (d) An image file format

Answer the Following
	 1.	 Define image processing. List and explain different types of image file formats.
	 2.	 How will you open and setup a new document in Photoshop? Also give the steps to save an image 

document.
	 3.	 List and explain common interface layout of image processing software, e.g., Photoshop.
	 4.	 How will you edit an image in a desired way?

Suggested Activities
	 1.	 Give a brief explanation of image processing.
	 2.	 Describe about image processing software and its function.
	 3.	 Demonstrate and explain the properties to be set in a document.
	 4.	 Set up a document like Page size and orientation, Resolution, Colour mode and Background content.
	 5.	 Edit image with cropping like Cropping with the crop tool, Cropping to a specific size, and Cropping 

with the marquee tool.
	 6.	 Resize image like Resizing to a specific size, Resizing Digital photo and Enlarging.
	 7.	 Correct image like Red Eye Removal, Hot Spot Removal, Adding Flash, and Colour Adjustment.
	 8.	 Scan your photograph and edit it in the desired size and colour.
	 l	 Resources: Computer, Image Processing Software, Scanner, Digital Camera.

Field Trip
	 Organize a field trip to various business houses and publications around you to get useful information about 

Image Processing and Multimedia Systems being used currently and present it in the class.
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Glossary
A

	 Absolute Reference: Commonly used in 
spreadsheet applications, it is a formulated cell 
reference that will not adjust when used to calculate 
the sum of specific cells.
	 Address Book: In e-mail, list of regular contacts’ 
addresses held in the e-mail software.
	 AI (Artificial Intelligence): It is the branch of 
computer science concerned with making computers 
behave like humans.
	 Animation: The display of a sequence of images 
in a computer program or on a Webpage to give the 
impression of movement.
	 Application Software: A program that is designed 
to perform specific tasks.

B
	 Backup: To copy files or data to a second source or 
media so as to safeguard it. 
	 Binary: A basic numbering system consisting of 1s 
and 0s. 
	 Bit (Binary DigIT): It is the smallest unit of 
processing of computerized data in terms of 1s or 0s.
	 Blog: (Slang term for a Weblog) A blog is a personal 
journal that can be accessed publicly and allow people 
to comment on the previously posted comments.
	 BMP (Bitmap): It is a standard uncompressed 
format for Microsoft Windows and IBM OS/2.
	 Browser: Software program that allows the user to 
find and read encoded information in a form suitable 
for display especially on World Wide Web.
	 Byte: A combination of 8 bits to represent computer 
data transfer or data storage measurement. 

C
	 CD-ROM (Compact Disc Read-Only Memory): 
A durable and low cost circular optical storage device 
widely used to store large amounts of information.
	 Clipart or Clip Art: A collection of image files that 
can be embedded or inserted into Web pages, word-
processed documents, PowerPoint presentations, etc.
	 Compiler: A type of system software that translates 
a source program usually written in a high level 
language into a machine language.

	 Computer Program: A set of instructions that the 
computer carries out to perform a given task.
	 Cropping: The process of removing portions of an 
image to create focus or strengthen the composition.

D
	 Data: A collection of raw facts and figures or a 
raw input which when processed or arranged makes 
meaningful output.
	 Database: A structured collection of data that can 
be used for a variety of purposes.
	 Defragmenter Utility Program: It finds all the 
scattered files on the hard disk and reorganizes them 
as contiguous files.
	 Desktop Publishing (DTP): Application software 
for laying out text, graphics and pictures in order to 
produce a professional-looking publication.
	 Digital Device: A device that works with discrete 
numbers or digits.
	 Disk Fragmentation: The scattering of portions of 
files about the disk in nonadjacent areas, thus greatly 
slowing access to the files.
	 Disk Cleanup Utility: It can search for and remove 
unnecessary files such as temporary files, or “temp 
files”.
	 DSS (Decision Support System): A computer-
based information system that provides a flexible tool 
for analysis and helps managers focus on the future.
	 DVD: Digital Versatile Disc or Digital Video Disc.

E
	 E-Commerce: Buying and selling or business 
transaction conducted on the Internet.
	 Electro Static Discharge (ESD): The release of 
static electricity when two objects come into contact.
	 EPROM: Erasable Programmable Read-Only 
Memory (“ee-prom”). It is a memory chip whose 
contents can be erased by a mechanism using ultraviolet 
light and reprogrammed for other purposes.
	 Ergonomics: The study of the interaction between 
people and machines.
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	 ESS (Executive Support System): An easy-to-
use Decision Support System made especially for top 
managers; it specifically supports strategic decision 
making.

F
	 Forms: Used to provide an easy to use interface for 
user to enter, view and modify data in a table.
	 Format Painter: Helps to copy the format that has 
been applied to text and apply it to another.
	 FTP (File Transfer Protocol): A software protocol 
for exchanging information between computers over a 
network.

G
	 GIF (Graphics Interchange Format): It is 
pronounced “jif”, supports upto 256 colours (8 bits per 
pixel).
	 Gigabyte (GB): 2 to the 30th power (1,073,741,824) 
bytes. One gigabyte is equal to 1,024 megabytes. 
	 GUI (Graphical User Interface): A program 
interface that takes advantage of the computer’s 
graphics capabilities to make the program easier to 
use. Well-designed graphical user interfaces can free 
the user from learning complex command languages.

H
	 Hacker: A person who spends his/her time trying 
to gain access to information stored on other people’s 
computers all around the world.
	 Hardcopy or Hard Copy: Printed output from a 
computer, as opposed to output on screen.
	 Home Page: The initial page of a site on the World 
Wide Web.

I

	 Icon: A picture or symbol to represent a command 
on a computer screen.
	 Image Processing: The set of computational 
techniques for analyzing, enhancing, compressing, 
and reconstructing images, generally with a digital 
computer.
	 Information: Meaningfully organized data.
	 Information System: A system that provides 
information to people in an organization.
	 Internet Explorer: A browser produced by the 
Microsoft Corporation and supplied together with the 
Windows operating system.
	 Internet: The Internet is a network of networks 

all of which use the same set of communications 
protocols. 
	 ISP (Internet Service Provider): A company that 
provides access to the Internet.

J

	 JAVA: A high-level programming language 
developed by Sun Microsystems.
	 Joystick: A device that looks a bit like a gear lever 
in a car. This is connected to a computer and is used 
mainly for controlling the cursor in fast action games.
	 JPEG (Jont Picture Experts Group): It is 
pronounced “jay peg”. It supports 16.7 million colors 
(24 bits per pixel).

K
	 Keyboard: An input device which is used to 
enter information which the computer displays or 
processes.
	 Kilobyte (KB): This is about a thousand bytes of 
space. In reality, it is two to the 10th power or 1,024 
bytes.

L
	 LAN (Local Area Network): A network that 
links together computers and peripheral equipment 
within a limited area, such as a building or a group of 
buildings.
	 Login: To attach to a computer using the user’s 
ID.

M
	 Megabyte (MB): About a million bytes of space. 
Actually it is 2 raised to the 20th power or 1,048,576 
bytes of space.
	 Memory: Internal storage areas in the computer.
	 MIS (Management Information System): A 
computer-based information system that uses data 
recorded by Transaction Processing System as input 
into programs that produce routine reports as output.
	 MPEG (Motion Picture Experts Group): A format 
to make, view, and transfer both digital audio and 
digital video files.
	 MS-Access: Database application software, 
provided by Microsoft.
	 MS-Excel: Spreadsheet application software, 
provided by Microsoft.
	 MS-PowerPoint: Presentation software, provided 
by Microsoft.
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	 MS-Word: Word processing application software, 
provided by Microsoft.
	 Multimedia: The integration of two or more types 
of information (text, images, audio, video, animation, 
etc.) in a single application.

N
	 Navigation: It is the process of finding the way, 
i.e., navigating, around a series of menus within a 
computer program or finding the way around the 
World Wide Web by means of a browser.
	 Netiquette: The rules of etiquette that apply when 
communicating over computer networks, especially 
the Internet. 
	 Node: In networks, a processing location. A node 
can be a computer or some other device, such as a 
printer.

O
	 OAS (Office Automation System): It combines 
various technologies to reduce the manual 
labour required in operating and efficient office 
environment.
	 Offline: Not connected to a computer or network 
of computers.
	 Online: Connected to a computer or network of 
computers, especially the World Wide Web.

P
	 PDF (Portable Document Format): A technology 
developed by Adobe and was designed to capture all 
of the elements of a printed document and place it in 
a single image file.
	 Pixel: The smallest element of an image that can be 
individually processed in a video display system.
	 Plotter: A computer output device that draws 
images on paper using a pen.
	 Podcasts: Online broadcasts that can be downloaded 
to portable devices.
	 Portal: A Webpage, website or service that acts as 
link or entrance to other websites on the Internet.
	 Printout: Anything produced on a printer after 
being processed by a computer program.
	 Primary Key: A set of one or more values in a 
database that uniquely identifies a record in a table.
	 Protocol: A set of rules governing the format of 
messages that are exchanged between computers.

	 Public Domain: Material that is copyright free, 
whose copyright has expired, or which cannot be 
copyrighted.

Q
	 Query: Used to retrieve information on a certain 
condition from a database.

R
	 RAM (Random Access Memory): A volatile 
computer memory available to the user for the 
temporary storage and manipulation of data. 
	 Relative Reference: The default reference in a 
spreadsheet package.
	 Resolution: A measure of the number of pixels or 
small dots displayed on a computer display screen, 
printer or scanner.
	 ROM (Read-Only Memory): A memory in which 
program instructions, operating procedures, or other 
data are permanently stored, generally on electronic 
chips during manufacture, and that ordinarily cannot 
be changed by the user or when power is switched 
off.

S
	 Scanner: A device used to convert hard copy, e.g., 
a printed page, photograph or photographic negative, 
into a form that can be stored on a computer.
	 Search Engines: A computer program that 
searches documents, especially on the World Wide 
Web, for a specified word or words and provides a list 
of documents in which they are found.
	 Sheet Tab: In spreadsheet applications, this refers 
to a tab at the bottom of a worksheet that acts as a 
means to identify or access different sheets within a 
workbook.
	 Slide Show: Used to display the slides in a desired 
sequence.
	 Software: The set of instructions used to direct 
the operation of a computer, as well a documentation 
giving instructions on how to use them.
	 Social Networking: The grouping of individuals 
or organizations into specific groups.
	 Source Code: Program code written in a high level 
language.
	 Source data: Data for which the chart is prepared.
	 Spreadsheet: A document which helps to organize 
data in rows and columns that intersect to form cells.
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	 System: Collection of related components that 
interact to perform a task in order to accomplish a 
goal.
	 System Software: It is a set of master programs 
that keeps the computer system working. 

T
	 Task bar: The bar that contains the start button 
and appears by default at the bottom of the desktop.
	 Terabyte (TB): 2 to the 40th power (1,099,511,627,776) 
bytes.
	 Tiff (Tagged Image File Format): It stores 
compressed files with a flexible number of bits per 
pixel.
	 TPS (Transaction Processing System): A computer-
based information system that tracks the transactions 
needed to conduct business.
	 Toolbar: A row or rows of buttons on a display 
screen that are clicked on to select various functions in 
a software application or web browser.
	 Topology: In networking, this refers to the physical 
or logical arrangement of a network.
	 Trojan: A type of computer virus that is loaded 
into an unsuspecting users system via a host program 
such as a free game.

U
	 Uploading: It means transmitting data from a local 
computer to a remote computer, as from your PC to a 
website you are constructing.
	 UPS (Uninterruptible Power Supply): It is a 
backup power unit that provides continuous power 
when the normal power supply is interrupted.
	 URL (Uniform Resource Locator): A protocol for 
specifying addresses on the Internet. It is an address 
that identifies a particular file on the Internet, usually 
consisting of the protocol as http, followed by the 
domain name.
	 User-friendly: Mainly used to describe software. 
Software that is easy to use and offers guidance if the 
user does silly things is described as user-friendly.
	 Utility Program: A program developed to run 
within an Operating System to perform a specific 
service.

V
	 Videoconferencing or Video Conferencing: A 
computer-based communications system that allows 
a group of computer users at different locations to 

conduct a “virtual conference” in which the participants 
can see and hear one another as if they were in the 
same room participating in a real conference.
	 Virus: A program or piece of code that is loaded 
onto your computer without your knowledge and 
runs against your wishes.

W
	 W3C (World Wide Web Consortium): An 
international non-profit organization which acts as a 
resource centre for the World Wide Web, and is active 
in setting technical standards.
	 WAV: Stands for WAVeform sound format. 
Microsoft’s format for encoding sound files.
	 Webcam: A camera connected to a computer and 
linking it to the Internet.
	 Web server: A computer that runs specific software 
to serve web pages to the Internet.
	 Web site: A connected group of pages on the 
World Wide Web regarded as a single entity, usually 
maintained by one person or organization and 
developed to a single topic or several closely related 
topics.
	 Wizard: A utility that provides guided sequence to 
perform complex task easily and quickly.
		 Wikis: Webpages that can be viewed and modified 
by anyone with a Web browser and Internet access.
	 Word Processor: Software that processes textual 
matter and creates organized documents.
	 Workstation: The computer attached to the 
Internet.
	 WWW (World Wide Web): Series of servers or 
computers that are interconnected through hypertext.
	 WYSIWYG: What You Say Is What You Get.

X
	 XML (eXtensible Markup Language): It is a markup 
language, not limited to Web documents.

Y
	 YouTube: A website to which we can upload our 
own video clips and view video clips uploaded by 
others: http://www.youtube.com.

Z
	 Zip Disks: The disks with a special high-quality 
magnetic coating that have a capacity of 100, 250 or 
750 megabytes.
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